
Ltd Software Suite
Version 16
Update and Release Notes

SHELL



Oasys Ltd LS-DYNA Environment Software Release Notes  
Version 16.0  

 

Ove Arup and Partners Limited |  Final |  March 2019  
 

 
 

Contents 
 
 Page 

1 Introduction 1 

1.1 Compatibility with LS-DYNA releases 1 
1.2 Hardware platforms supported 1 
1.3 Graphics hardware supported 1 
1.4 FLEXlm Licensing 2 
1.5 Important T/HIS JavaScript Update 2 

2 Bugs Fixed 3 

2.1 PRIMER 3 
2.2 D3PLOT 30 
2.3 T/HIS 36 
2.4 REPORTER 41 
2.5 SHELL 43 

3 Enhancements  44 

3.1 PRIMER 44 
3.2 D3PLOT 52 
3.3 T/HIS 57 
3.4 REPORTER 63 
3.5 SHELL 64 

 
 



Oasys Ltd LS-DYNA Environment Software Release Notes 
Version 16.0 

 

Ove Arup and Partners Limited |  Final |  March 2019  
 

Page 1 
 

1 Introduction 
The Oasys Ltd LS-DYNA Environment 16.0 suite, dated March 2019 is a full release which 
supersedes all previous releases. 

This document lists the enhancements that have been made during development, and the bugs 
that have been fixed (since 15.1). Each “case id” referred to in these lists is unique and should be 
cited if more information or clarification are required. 

 

1.1 Compatibility with LS-DYNA releases 
The 16.0 release has been used and tested with LS-DYNA version R11.0, and supports all the 
keywords in volumes I, II and III of the R11.0 User’s Manual dated October 2018. 

LS-DYNA R9.0 is now the default keyword output format from PRIMER. (However output may 
be generated for later releases of LS-DYNA.) 

 

1.2 Hardware platforms supported 
The complete Oasys Ltd LS-DYNA Environment 16.0 is available on the following platforms: 

Windows  Windows 7 
Windows 10 

64 bit 

Linux RedHat Enterprise 6.x, RedHat Enterprise 7.x 
SUSE Enterprise 12.2 

64 bit 

For simplicity of support and maintenance only the RedHat Enterprise 6.x build has been 
released on the website as this has been found to run on most machines. 
If you require a different Linux build, please contact Oasys Ltd. 
 

1.3 Graphics hardware supported 
The default graphics protocol used on all platforms in the table above is OpenGL, which gives 
good quality 3D performance on a wide range of hardware. 

“Legacy” X-Windows (2D only) graphics drivers remain in PRIMER on Linux platforms only, 
since these are used by a small minority of clients who display over a network of mixed machine 
types. However this X driver is not maintained or updated and will give poor performance, so it 
should only be used as a last resort.  There are much better “thin wire” graphics solutions 
available today, and Oasys Ltd can give advice about these on request. 
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1.4 FLEXlm Licensing 
The version 16.0 software has been compiled using version 11.14.1 of FLEXlm. 

Customers still using a v15.0 or earlier license file will require a new license file to run v15.1 or 
v16 software, this will be backwards compatible for all versions. 

The version 15.0 license file and license daemons are backwards compatible with both the 14.x 
and 13.x software releases. This means that any existing 14.x and 13.x software will continue to 
work with new license files and servers. 

If you are not already using the license servers that shipped with the v15.x software we 
recommend that you update all of your Oasys Ltd LS-DYNA environment license servers 
with the files shipped with the version 16.0 software. 

 

1.5 Important T/HIS JavaScript Update 
If you are upgrading from version 14, any JavaScript written for T/HIS 14.0 and 14.1 which used 
data components will not run in version 16.0.  If you are already using version 15.0 or later then 
your version 15 JavaScripts require no changes. 

 
This is because in T/HIS 14.x the data component constants were global constants.  They could 
over-write other variables used in the script.  From T/HIS 15.0 onwards, data components are 
accessed by a Component class. 

 
To correct your scripts which use data components make the following change to functions 
QueryDataPresent() and GetDataFlagged(): 

Version 14.x: 
m.QueryDataPresent(DX, Entity.NODE); 
curve_array = m.GetDataFlagged(f, DX); 

Version 15.x and 16.0: 
m.QueryDataPresent(Component.DX, Entity.NODE); 
curve_array = m.GetDataFlagged(f, Component.DX); 

  



Oasys Ltd LS-DYNA Environment Software Release Notes 
Version 16.0 

 

Ove Arup and Partners Limited |  Final |  March 2019  
 

Page 3 
 

2 Bugs Fixed 
The enhancements and bug-fixes for each program have been broken down into a series of 
topics.  Within each topic enhancements and bug-fixes are listed by case ID. 

2.1 PRIMER 

2.1.1 Bugs Fixed in 16.0 

Adhesive 

• Case 37558 
PRIMER was not using the 'Percentage made' setting for adhesive runs when reporting errors. 
This has been corrected. 

Airbag 

• Case 39800 
PRIMER will set the VSCA and PSCA *AIRBAG fields to 1.0 if they are left at 0.0 by the user. 
This is because LS-DYNA can terminate if they are not set to the default values of 1.0. However, 
PRIMER only did this with the first airbag written out - if multiple airbags where present in the 
model the subsequent ones were written with these fields remaining at 0.0. This has been 
corrected. 

• Case 39750 
Primer didn't accept -ve load curve values for LCIDM LCIDT fields in *AIRBAG_HYBRID 
card. Fixed this problem. 

• Case 39200 
Reading of ill-conditioned *AIRBAG_SHELL_REFERENCE_GEOMETRY could cause 
SIGSEV when the edit panel was used. Now fixed. 

• Case 34915 
When display option was set to swapped coordinates, orientation of explicitly selected airbag 
reference geometry was changing the actual nodal coordinates instead of the reference ones. This 
wrong behaviour has been blocked and a help message added to direct the user to select the 
airbag parts if PRIMER is in swapped coordinates mode. 

Belts 

• Case 39465 
Belt fitting from the command line /BELT command caused a crash when the following 
sequence was followed:  

+ Read model  
+ /BELT  
+ PR_REFIT (to set refitting properties)  
+ MAX_ITER 1000  
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+ DONE  
+ REFIT  

Then delete the model and repeat the process above, which caused a crash after 'MAX_ITER'.  
 
This happened because the command-line belt fitting property update presumed that the fitting 
panel was 'live' (from the first iteration) when in fact it had been deleted when the model was 
deleted.  
 
This has been fixed by using a more rigorous 'does the belt fitting panel exist?' test prior to 
updating it. 

• Case 39388 
A crash occurred during seatbelt remeshing that was traced to problems with 2d seatbelt 
elements 'coiled up inside' a retractor waiting to be pulled out. It appears that the topology and or 
connectivity of these internal elements contained errors, meaning that they could not be 
connected to the belt proper.  
 
The crash occurred due to an internal error when trying to report the connectivity problem, and 
this has been fixed. 

• Case 39340 
When auto-refitting a seatbelt 'Old' geometry has to be moved over to 'New', and this could lead 
to nodes being duplicated in sets. This would only happen if:  

- The node was at a 'fixed' location on the belt, typically at the ends, and so survived the 
remesh operation without being modified.  

- The node was also in a node set that had no connection with the seatbelt.  

Fixed by more careful inspection of set contents to see if a node is already present in them before 
copying it over. 

Checking 

• Case 39820 
The check suppression comment was not being saved properly for materials with result that 
Primer failed to suppress the check when file was written and read back in. Now fixed. 

• Case 39594 
MAT_THERMAL_CHEMICAL_REACTION no longer displays spurious suffices in Check 
error tree panel. 

• Case 39385 
The node coincidence check for spherical joint was inconsistent with LS-DYNA R9.0 and above. 
Now fixed. 

• Case 38901 
Added keyout warnings for these Keyword Fields:  

1. DEFINE_CPM_CHAMBERS: Suffix _TITLE is not supported for versions less than R8  
2. AIRBAG_PARTICLE: Negative VD values should be supported from R9 onwards. 

Added a standard AIRBAG warning : This definition will require manual editing in order 
to run.  
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3. AIRBAG_PARTICLE: STYPE3=2 should be supported from R9 onwards. Added a 
standard AIRBAG warning : This definition will require manual editing in order to run. 

• Case 38829 
A model with illegal *CONSTRAINED_RIGID_BODY where PID was defined as zero caused 
a crash in model check. Now fixed. 

• Case 38759 
The recheck function on check tree which applies after edit or auto-fix now takes account of any 
categories that are excluded from checking on the main drop-down. This is particularly useful 
when the lengthy contact checking is switched off. 

• Case 38608 
The value of *CONTROL_THERMAL_SOLVER <eqheat> variable was changing after a model 
units conversion. This has now been fixed such that the value of does not change with a units 
conversion. 

• Case 38273 
When deleting an entity, that is being referenced by a warning/error/message etc. in the Dyna 
Output tree, via processes external to the Dyna Output tree, if the User were to then attempt to 
edit that entity via the Dyna Output tree PRIMER would print out error statements/crash. This 
has now been fixed. 

• Case 37683 
The user can now specify whether elements with MAT_NULL are included/ignored in element 
quality checking (Tools → Check) and in element quality CT/SI plots. For Tools → Check, 
including/ignoring null elements can be specified by a check box in the Tools → Check → 
Options panel (labelled 'Ignore null elements'), as well as the preference 
'ignore_null_part_element_checks'. For CT/SI plots, a set of radio buttons has been added to the 
CT/SI element quality settings panel, which determine how null elements are drawn. Null 
elements are included when 'Drawn normally’ and ignored otherwise. 

Clipboard 

• Case 39843 
On the clipboard the 'propagate selection' tool has been renamed 'Find referenced items' and the 
logic modified to do that. 

• Case 39372 
The 'find referenced' function on the clipboard only found parameters which referenced the 
directly selected items, when it should find any that reference items of the propagated selection. 
Now fixed. 

• Case 39019 
On a model with connections with no layers defined, the find referenced tool on the clipboard 
incorrectly selected these connections. Now fixed. 

• Case 38228 
The function finds referenced items on the clipboard did not behave sensibly when a contact with 
exempted part sets was treated. This has been changed so a warning is given, and the part set is 
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left latent. The correct action may be to create an inverse part set and change m/sstyp to 2 on the 
contact before putting it on clipboard. This however is beyond the scope of clipboard. 

Compare 

• Case 39528 
The compare tool which is used to compare FE mesh with IGES surface data using a contact 
type algorithm was running rather slowly due to less than optimal bucket setup. This has been 
improved considerably. 

Composites 

• Case 39947 
It is now possible to locate a spot-weld accurately on a Shell Nurbs Patch element, as the 
location on the nurbs surface is now determined properly. 

Connections 

• Case 39752 

Empty of modular bolt on connection table removes the section, material, etc associated with the 
bolt part if it can be cleaned up. Deletion of modular bolt on table, however, failed to remove the 
unwanted section, etc. Now fixed. 

• Case 39690 
A keyword file containing *CONNECTION data was written out using binary format, and then 
subsequently generated keyword input errors when read back into PRIMER.  
 
In fact, the binary i/o was correct, but it exposed an error in the way a particular type of open-
ended *CONNECTION spot-weld card was being processed during keyword input, and the fact 
that it has read in correctly up to now was pure luck. Now corrected, and it reads correctly in 
both ascii and binary formats. 

• Case 39637 
Part replace now has an option to process HAZ welds or not. Previously the processing was 
unconditional. With the option OFF, HAZ welds will not be unmade at the beginning of replace 
or re-made at the end. This means an imported mesh which has holes prepared to mate to the 
HAZ weld can simply be attached using the merge process, provided the HAZ shells belong to a 
different part to the main one.  
There is a pref setting - part_replace_process_haz_connection: OFF 

• Case 39566 
Plotting of NRBs defined by SET_COLLECT did not respect convention that first node in the set 
is master node and consequently did not draw the expected 'spider'. Now fixed. 

• Case 39317 
Import of bolt module containing *DEFINE_CURVE can create unwanted *DEFINE_TABLE, 
*DEFINE_FUNC at same label in the entity list. These had to be removed before the model can 
re-read. Now fixed. 
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• Case 38907 
Import of bolt module containing static items (e.g.*CONTROL) which clash with items in main 
model was causing SIGSEV. Clashing static items are now culled before import and should the 
operation fail for other reasons, it will now end gracefully. 

Constraints 

• Case 38932 
Added drop down options for IDOF and DOF columns for 
*CONSTRAINED_INTERPOLATION and *CONSTRAINED_LINEAR respectively. 

Contacts 

• Case 39819 
The contact penetration checker wrongly reversed the effect of shell reference surface offset 
NLOC, and suffix _OFFSET, for triangular elements. Quads were OK. This was caused by 
accidental reversal of the normal vector of triangular elements in this context, now fixed. 

• Case 39816 
When a contact surface used an 'excluded part set', that is type 6 for SSTYP (slave side) or 
MSTYP (master side) the contact checker could sometimes nevertheless include shell elements 
on excluded parts in the penetration check when the model contained solid or thick shell 
elements.  
 
This was due to an error in the logic which looks for shell elements on faces of 3d elements in 
the contact (by default LS-DYNA prefers the shell in this situation). It would choose a shell on 
such a face without checking whether it was in an excluded part set.  
 
An extra test has now been added which prevents excluded shells being chosen, correcting this 
problem. 

• Case 38663 
When dragging nodes without any shells (for example on solid elements) in the contact 
penetration fix panel with the local normals option, PRIMER corrupted the coordinates of the 
nodes, so the nodes and adjacent elements became invisible.  
 
The movement vectors used for the dragging are based on adjacent shell normals. Now there is a 
message explaining this and suggesting other fix options when nodes on solids are selected. 
PRIMER leaves the coordinates of the affected nodes unchanged. 

• Case 37894 
When writing a *CONTACT definition with _MORTAR suffix in an LS-DYNA version not 
supporting _MORTAR (older than 971R5), the whole contact card was omitted from the 
keyword file. Now Primer writes it just without _MORTAR. 

• Case 37554 
For Tiebreak contacts, can now take negative values (except for when = -2, 2, 4) via the keyword 
edit panel. Additional model checks have also been added to display errors when is out of range. 
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• Case 37102 
The correct tolerance for tiebreak contact checking is now applied. This is described in note 10 
under *CONTACT of the LS-Dyna manual and is different for MPP and SMP. 

Contour 

• Case 39204 
For highly warped shells or solids the calculation could give an artificially low warp angle 
because the maximum thresh-hold to keep the calculation well-conditioned was conservatively 
set to 135 deg. This has been increased to 180 deg and highly warped elements should now be 
reported correctly. An oa_pref (maximum_warpage_criterion) can be set in range 0…180. 

• Case 38043 
When doing a contour plot, 'Internal faces' is now always ON 

Copy 
• Case 38833 
In some internal copy operations, for example when using the Copy button on the docked panel 
for a keyword or when saving selected items as a new model from the clipboard, a few keywords 
were not copied at all. This affected the following:  

- * ELEMENT_INTERPOLATION_SHELL and 
*ELEMENT_INTERPOLATION_SOLID when no elements of other types were 
selected,  

- *FREQUENCY_DOMAIN_ACOUSTIC_SOUND_SPEED when no frequency 
definitions of other types were selected,  

- *NODE_MERGE_SET and *NODE_MERGE_TOLERANCE when no other 
*NODE_xxxx keywords were copied.  

This has now been fixed. 

Cut section 

• Case 38367 
Display option for true sections of shells and beams now has OPTT option for use of contact 
thickness. Cut section panel also has new options for beam plotting. 

Database 

• Case 39619 
When creating a *DATABASE_CROSS_SECTION card the new definition was drawn but then 
a sketch was immediately done obscuring the card just created. The sketch is no longer done so 
you can see the section you have just created. 

• Case 39148 
The database was never designed to work with MAT_ADD_EROSION. User need to select 
MAT_ADD_EROSION on edit panel to read through database. Now manually turning on 
MAT_ADD_EROSION if it is being read from database panel to support it. 
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• Case 38964 
Corrected keyword file read problem and added checks for DATABASE_RECOVER_NODE. 

Deleting 

• Case 39503 
Clean up unused has been corrected to remove morph points when a morph box is removed by 
clean-up. 

• Case 39456 
All Volume III panels are now unmapped on model delete (as per Volume I). 

Dummies  

• Case 39770 
In the dummy positioner, 'Move nodes' panel, it is possible to move a point on an assembly to a 
node position. This worked if the node label was typed in, but failed and generated error 
messages if the popup was used to select or pick a node. Internal initialisation error, now fixed. 

• Case 39147 
The combined dummy and seatsquash tool did not work with the THOR dummy. After 
positioning it, the model could end up with parts sticking out of the dummy. This has been fixed. 

• Case 39036 
Normally child assemblies in a PRIMER dummy definition rotate about a defined node on their 
parent assembly, but it is legal (if unusual) to set that node to zero, meaning 'rotate about dummy 
H-Point'.  
 
This caused a crash in mechanism-style positioning (drag or move points) due to an internal error 
that presumed the node would always be defined.  
 
A warning has also been added to the dummy assembly check function, telling the use that while 
this is legal it is unusual, and asks did he really mean that? 

• Case 38976 
Positioning a dummy multiple times could result in the model being scaled. This was due to 
some internal problems with storing the direction cosines of assemblies, which could accumulate 
and end up being significant. This has been fixed. 

• Case 38967 
The Unit of global damping is set to rad/sec. 

Edit 

• Case 39481 
The *SECTION keyword editor is slightly unusual in that it treats the element formulation value 
ELFORM as a (pseudo) keyword suffix. This is because changing ELFORM usually also 
changes the layout and meaning of many fields on the card, so ergonomically it is closer to 
'change a keyword suffix' than it is to 'change a data field'.  
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The special logic required to handle this was not working correctly if the ELFORM value on any 
row was changed to a value not currently present in any rows displayed by the editor. In effect it 
was not setting up the (pseudo) keyword suffix correctly, and this could result in lines 2 onwards 
not being displayed for that card and consequential errors from the data in these fields being 
zero. This has been fixed. 

• Case 39177 
The function to allow multiple picking of the nodes via the object menu has been fixed for create 
of Multiple *INITIAL_FOAM_REFERENCE_GEOMETRY cards. 

• Case 38965 
The quickfind function could not find some *CONTROL cards to create, modify, delete, etc. 
They have now been added to the list. 

• Case 38778 
A criticism of the keyword editor was that 'wide' (e.g. A70 or A80) character fields only 
extended to the width of subsequent numeric data columns, meaning that if data for a keyword 
only had one or two columns a character title field would be very narrow, making it difficult to 
see titles. A typical example was *DATABASE_HISTORY_xxx  
 
This has now been corrected. Character fields now count towards the overall width of the 
keyword editor, so an A70 field will occupy the equivalent of 7x 10 wide columns. 

• Case 37939 
Modifying the entity label from edit panel and then doing 'UNDO' created a duplicate entity 
instead of relabelling the entity back to original label. Solved this problem. 

• Case 35658 
Parameter handling in Open ended keyword like 
*AIRBAG_SHELL_REFERENCE_GEOMETRY was missing in open lists. Fixed this. 

Elements 

• Case 38835 
Keyword editors have been added for *ELEMENT_INTERPOLATION_SHELL & 
*ELEMENT_INTERPOLATION_SOLID which can be accessed via keyword → ELEMENT → 
INTERPOLATION_SHELL/SOLID. 

Filename 
• Case 39856 
When writing a DCF (occupant position file) on LINUX, if you typed in the name of a file that 
did not exist, the file selector would give an error. This has been corrected. 

Filtering 

• Case 38352 
When a text filter is applied to an object menu (for example for parts in the Blank or Remove 
menu), then All_Vis selected all entities on the menu, not just those remaining after applying the 
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filter. Now it respects the filter. Also, when screen-picking entities, only those remaining after 
the text filter are now actually selected. 

• Case 37727 
Preferences 'extensions_for_file_read_on_unix' and 'extensions_for_file_read_on_windows' are 
obsolete. These are both now served by 'extensions_for_file_read'.  
The pref may be written either in the form '*.k* *.gz *.zip' or '*.k*;*.gz;*.zip'. 

Geometry 

• Case 39574 
The Mesh → Geom tool could sometimes fail to mesh a surface if it tapered to a point. This has 
been fixed. 

Graphics 

• Case 39652 
In the Entities panel, pressing the Geometry → All Geometry switch did not turn on/off the 
display of attached points. This has been fixed. 

• Case 39621 
Previous versions of PRIMER could sometimes write constraint labels (Node plot) multiple 
times on the screen if users modified associated data settings (Entities). These labels could even 
get displayed at slightly different locations if rotation or zoom operations were performed in the 
interim. This issue has now been fixed. 

• Case 39255 
The *DEFORMABLE_TO_RIGID keyword was handled in rather a half-baked way in 
PRIMER: not really drawn properly in all contexts and without a keyword editor. It has now 
been implemented 'Properly'. In summary: 

- D2R is now drawn 'Properly', as in its entity etc switches can be controlled from the 
entity panel.  

- This, among other things, means that 'Only' now works in the various contexts where 
you'd expect it to.  

- The original 'Only' capability on the [Keyword] D2R panel is now replaced with the 
standard version.  

- As part of this sketching now works, including find the centre for cross-hairs.  
- Autoscale and visibility calculations now work.  
- Picking and area selection now work.  

(Note that a keyword editor for D2R was also added in PRIMER 16.0) 

• Case 39220 
The option colour by include file would result in SIGSEV in the drawing operation for items 
newly created. Now fixed. 

• Case 38011 
When parts are coated with shells (Mesh, Coat tool) it was sometimes the case that the new shell 
parts were not visible when the model was redrawn, making it hard to know whether the coating 
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had actually taken place on the correct parts.  
 
The reason for this is that coating shells are coincident with the solid / thick shell faces that they 
coat, so one of the two element faces has to 'win' when they are drawn, and this tended to be the 
element of the part with the highest label since this is drawn last. So if the part of the coating 
shells had a lower label than the 3d part being coated the shells would not appear.  
 
This has been fixed by changing the way coating shells are drawn while the 'coat' panel is open:  
 
- They are lifted slightly above the underlying 3d element face, meaning that they will always be 
visible, regardless of the part label.  
 
- They are drawn in a 'chequer-board' fashion, technically 'stippled', giving a patchwork effect in 
which alternate squares show coating and coated parts. This makes it possible to visualise both 
parts, and to verify that the correct elements are coated.  
 
The degree of stippling, effectively the size of the squares, can be controlled. 

• Case 37173 
Model modified → Parts → geom: Wireframe disappears on zoom and reappears on rotate. 
Fixed the graphics issue. 

• Case 36751 
Contouring Shell Normals Levels & Forms menu not updating the colours in the shells when 
changing the Level Settings. Now fixed. 

Help 

• Case 39217 
Added help panel for some of the volume III keywords. 

Image 

• Case 38944 
The .png file reader in PRIMER (and the other Oasys software) worked correctly for the 
commonplace 8 bit and 24 bit .png formats, but failed or even crashed when it tried to read some 
of the less common .png formats, notably 1 bit deep black and white.  
 
It has been rewritten to handle all the plausible .png file formats:  
 
1 bit black and white  
8 and 16 bit greyscale, with and without transparency  
2, 4 and 8 bit indexed colour  
8 and 16 bit RGB colour, with and without transparency  
 
Note that the .png writer still only generates the common 8 bit indexed and 24 bit RGB file 
formats. 



Oasys Ltd LS-DYNA Environment Software Release Notes 
Version 16.0 

 

Ove Arup and Partners Limited |  Final |  March 2019  
 

Page 13 
 

Include 

• Case 39659 
When filtering Include files in object menus using the Text filter the process would not work 
correctly the first time the menu was built, typically failing to show include files with names 
matching the filter. Any operation which caused the menu contents to be rebuilt would then 
show the correct include files.  
 
Caused by an internal error which initially skipped all child include files if the master filename 
did not match the filter string, now fixed. 

• Case 38745 
The “add new child” directory icon of include tree refused to accept READ-ONLY files 
(windows only). Now fixed. 

• Case 38695 
PRIMER would crash when trying to input data in the field of *INCLUDE_UNITCELL. This 
has now been fixed. 

Javascript API 

• Case 39832 
JSON files produced by the Model Check method would be invalid if there were errors or 
warnings for either character labels or sets using _COLLECT as in these cases the labels would 
not be integers and need quoting to make a valid JSON file. This is now fixed. 

• Case 39560 
The Xrefs GetType method could return the wrong value in some cases when items were deleted 
from a model in PRIMER. Now fixed. 

• Case 39507 
The FlagCut method in the CrossSection class did not work. Now fixed. 

• Case 39498 
If an InterpolationSpotweld.js file was put in the primer_library/scripts/check folder to add a 
custom check for Interpolation Spotwelds the script didn't run and an error message saying it was 
invalid was displayed. This has now been fixed. 

• Case 39239 
The FindLineStarting and FindLineContaining methods in the File class did not return undefined 
when if the file was at EOF (end of file). Now fixed. 

• Case 39151 
The return code from the System() command on Linux could occasionally be incorrect. Now 
fixed. 

• Case 39146 
Calling the Execute command many times on Linux could cause PRIMER to crash. Now fixed. 
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• Case 39099 
LOAD_BODY Keyword now can be moved into desired INCLUDE file along with other 
keywords. 

• Case 38742 
Custom JavaScript checks were not working for some classes. Solved this problem. 

Keyword 

• Case 39729 
PRIMER was incorrectly producing error messages for *BOUNDARY_CONVECTION when 
<HLCID> and <TLCID> were not specified but <HMULT> and <TMULT> were . This has 
been corrected, also with the addition of an error message indicating that <TLCID> and 
<TMULT> are both not set. 

• Case 39337 
The optional 5th card on the *CONSTRAINED_INTERPOLATED_SPOTWELD keyword was 
not being written out for LS-DYNA version R10. This has been corrected. 

• Case 39088 
Removed support for suffix _TITLE for *DEFINE_CPM_VENT as it is not supported in LS-
Dyna. 

• Case 38192 
For *CONTROL_FORMING_UNFLANGING, a new option _OUTPUT and an additional card 
for the option (both introduced in R8) were missing. This has now been rectified. 

• Case 37885 
PRIMER now reads the _WRITE option for *INITIAL_LAG_MAPPING correctly. 

• Case 37658 
_EXCLUDE option has been added for create panel for 
INTERFACE_SPRINGBACK_EXCLUDE. 

• Case 37539 
When running a cleanup on a *DEFORMABLE_TO_RIGID with an empty part set, there was 
an error message. Now the *DEFORMABLE_TO_RIGID definition appears correctly on the 
deletion menu in this situation. 

Kwd editor 

• Case 39902 
In the *CONTACT keyword editor the following sequence:  

+ Highlight multiple rows  
+ Change field SPR in one of the highlighted rows  

Would result in the adjacent MPR field being changed in the highlighted rows that were not 
explicitly changed.  
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This was a generic Keyword Editor bug, so not related to *CONTACT, and was caused by 
copying 8 bytes for an integer data field instead of 4 bytes, causing changes to 'spill over' into the 
next data field to the right. This would only happen when multiple rows were highlighted for 
editing and would only affect the rows in which the original change had not been typed. 

• Case 39577 
Macro run on keyword editor of types that can use character labels (e.g. part keyword editor) 
would fail when trying to edit field of item defined with character label. Such labels need to be 
resolved to the Primer's internal (-ve) label to enable the macro. 

Labels 
• Case 39861 
In the visualise renumber panel the 'free' ranges were not displayed correctly when at the start of 
the row (before the first 'used' block) or in the ALL row when between two used blocks with no 
space in-between. Now corrected. 

Macro 

• Case 39335 
Macros did not work for the *ELEMENT_GENERALIZED_SHELL and 
*ELEMENT_GENERALIZED_SOLID editors. Now fixed. 

• Case 38931 
Macro recorded for *INCLUDE_UNITCELL was not working properly for ECN_ fields. Fixed 
this issue. 

Mass 

• Case 38407 
When calculating Part Inertia properties on 'insert properties' function of part edit panel, Primer 
now includes the effect of user defined coordinate system CID. Additionally, the mass 
calculation has been improved to include slave rigid bodies and attached mass. 

• Case 37992 
For nodal massing, an option 'include attached mass of ASSM at higher label' has been added to 
the assign mass modify panel. This gives parity with part massing where over-massing 
definitions overwrite mass of junior ones. There is also a pref. The default for 
primer*assign_mass_includes_attached_mass is “free_and_lower” (consider only assign mass of 
lower label) but this may be changed to “all”. 

Materials 

• Case 39809 
Fields U_n, P_n on *MAT_USER_DEFINED are now written as integers if rounding permits if 
the preference 'enable_integers_for_mat_user_defined' is set to ON. By default they are written 
as floats as per the manual. If these fields are used as large labels (15 digits) then the preference 
needs to be on. 
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• Case 38874 
The numbers of *MAT (STRUCTURAL), *NODE, *PART, and *RIGIDWALL keywords 
present were not always correctly shown e.g. in the Keyword → MAT popup box when other 
material keywords (such as *MAT_NONLOCAL) were present. This has now been fixed. 

• Case 37553 
Now *MAT_157 can be used with solid elements. Primer’s material vs element compatibility 
tables have been updated. 

Measure 

• Case 38726 
In the Vector input text box for 'Node to Node' Measure, the cursor position in the text box input 
for the Vector was set to the end by default, thus hiding the value of the X dimension. Corrected 
this behaviour by moving the cursor position to zeroth place in the input box, so that the text is 
shown as Left justified in the text box 

Mechanism 

• Case 39918 
PRIMER crashed when reading a keyword file in which *POSITION data inside a mechanism 
had been hand-edited (and muddled up!) in a way that made it invalid. The crash was caused by 
the internal confusion that this caused.  
 
This has been fixed by making the reading of *POSITION cards more robust, and in assembly 
position data can appear in any order or be missing altogether.  
 
However, it must be stressed that hand-editing *POSITION data should ideally not be done, or if 
it must be done then with great care. If data are corrupt or missing PRIMER should no longer 
crash, but the results of trying to retrieve a garbled position are likely to be wrong and to 'pull the 
mechanism apart'. 

• Case 39777 
A problem arose with Mechanism positioning in PRIMER 15 if the mechanism definition 
contained saved positions (*POSITION data) and it was moved outside PRIMER.  
 
In previous versions this wouldn't matter, but in PRIMER 15 the centroids of assemblies as 
defined in the reference *POSITION data block were used as part of the 'assemble data for 
dragging' process, so if these centroids were a long way from the actual assembly centres the 
mechanism would refuse to move because of the artificial moments implied by motion about a 
distant centroid.  
 
This has been fixed by changing the definition of 'assembly centre' used for mechanism dragging 
to a value calculated dynamically from each assembly's current position, meaning that 
positioning is independent of any saved *POSITION data.  
 
This in turn means that in PRIMER 16 it is acceptable once more to move (translate and/or 
rotate) a mechanism as a whole outside PRIMER. This will no longer affect the positioning 
process and saving / retrieval of stored positions will also still work.  
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However, if individual assemblies are moved relative to one another outside PRIMER then 
positioning will still work but saving and retrieval of saved positions may give the wrong result. 

• Case 39504 
Mechanisms and Dummies permit positions to be saved and restored, and this worked fine for 
the quasi-rigid bodies that made up the assemblies. It didn't work correctly for any 'stretches' 
applied to non-assembly structure, which tended to go more and more wrong as retrievals 
multiplied.  
 
This was a logical error that has been solved by reverting to the pre-positioner status (equivalent 
to 'reset all') prior to restoring a position. This has two advantages: the first being that it fixes the 
logical error, the second being that a 'reset' restores all nodal coordinates and associated data 
precisely from backup storage, removing any small cumulative errors that may have built up 
from positioning in the meantime. 

Menus 

• Case 38142 
Quick pick menu item 'Read S.P.' gives obscure idea what it does. A popup is added for the 
button that convey a better idea what the button does. 

Merge 

• Case 34525 
On object menus for include file selection the name 'Master model' has been renamed to 'Master 
file'. This name appeared for example in the selection of a destination include in Model → 
Merge, and there the same term 'master model' is used at the same time for one of the source 
models, the other one of which is referred to as slave model. To avoid confusion, the master 
include file of any model is now referred to as 'Master file' in the menu.  

Mesh 

• Case 39784 
Mesh Tools → Shell Box tool does not create the closed box if the number of elements in any of 
the axes=1. Fixed this. 

• Case 39325 
Reduced likelihood of creating rhombus shaped elements when meshing by enforcing max quad 
angle preference of 140 degrees. 

• Case 39192 
When splitting shells occasionally a node was not attached (depending on the attached shells). 
The logic to find nodes to attach has been improved. 

• Case 39087 
Remesh Area now produces consistent meshes if Reject is pressed before confirming. 
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• Case 39058 
When using the remesh area tool if some manual fixed points were added and then a feature line 
added or removed the fixed points would be deleted. Now fixed. 

• Case 39057 
When remeshing an area if the user clicked outside the area near a red shared/locked edge then 
PRIMER could crash. Now fixed. 

• Case 38818 
While creating a Hole in PRIMER, if the Washer PART IDs are changed after the Hole is 
initialized, the newer washer rings do not get created under the updated Part IDs. Fixed this. 

• Case 38595 
A pop up in Split elements panel was not clear about which type of elements it is applicable to. 
Changed the text in the pop up to make it unambiguous. 

• Case 38279 
The mesh size used when remeshing around spotwelds is now the average edge length of the 
surrounding shells rather than the maximum edge length. Consequently, surrounding shells no 
longer increase in size when a connection is repeatedly remeshed. 

• Case 38024 
The calculation method for determining the coordinates of nodes, when creating 
spherical/hemispherical/cylindrical meshes, has been altered such that better quality elements are 
produced. 

• Case 37200 
Splitting quad shells into two triangles is now done such as to maximise the minimum resulting 
triangle angles (rather than just splitting along line joining node 1 and node 3). This algorithm is 
used in both shell splitting and tet meshing. 

Model build 
• Case 39367 
The model-build-from-csv type GENERAL_TRANSLATE_PARAMETER was not processing 
parameters correctly. This has now been fixed. This build type has no interactive panel support at 
present. 

Model modified 

• Case 38923 
Listing of differences in character data fields by model modified has been corrected to remove 
leading space. 

• Case 38690 
Model modified sometimes didn't find existing differences in character data fields. This has now 
been fixed for the following:  

- FILENAME on *CONTROL_FORMING_PARAMETER_READ  
- SE_FILENAME on *CONTROL_IMPLICIT_STATIC_CONDENSATION  
- PTYPE on *DEFORMABLE_TO_RIGID  
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- PTYPEI and PTYPEJ on *DEFINE_FRICTION  
- ANGTYP on *LOAD_BODY_GENERALIZED 

• Case 37655 
Model modified can give spurious warnings about differences between contacts particularly 
when run the second time when cached data is being used. The code has been revised so that re-
use of contact interaction data is now more rigorous. 

Morphing 

• Case 39314 
Nodes and coordinate systems from multiple models can be selected on the morph tab of the 
MORPH tool. 

• Case 39222 
In the Reset tab of the mesh morphing menu, morph boxes can be selected from all models when 
more than one model is in the current PRIMER session. However, when clicking the button to 
reset them, only boxes from one model were reset. This has now been fixed. In PRIMER 16.0 
the Reset menu is now part of the Utilities tab. 

• Case 39193 
When creating a morph box interactively with all selected nodes in a plane parallel to one of the 
planes defined by the selected coordinate system, PRIMER created morph boxes where one or 
more side lengths of the cuboids were zero, so it had got coincident morph points at its corners. 
In PRIMER 15 there was already an option for the minimum morph box size in the program 
options, which is 10.0 by default, but that was not working as it should. This has now been fixed.  
 
Also, there is a preference morph_box_min_size for this minimum size. This preference was 
there is PRIMER 15, but the documentation and entries on the preferences editor were 
incorrectly listing morph_threshold and morph_offset, which would not have been recognised by 
PRIMER. 

• Case 38979 
When a morph box is created in the Morph panel, the panel now automatically switches to the 
Morph tab. 

Orient 

• Case 38764 
Orient to contact now performs physical contact test ignoring the logic which removes 
penetrations between rigid bodies which are slaved together. This logic remains for LS-DYNA 
contact analysis (where it is switchable) but in this context is inappropriate. 

Output 

• Case 39748 
Writing out a DesignLink file for a model containing beams could cause PRIMER to crash. This 
has been fixed. 
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• Case 39235 
PRIMER checks all *INCLUDE_TRANSFORMS for label offsets which, when the file is 
written out, could result in illegal -ve labels when subtracted from the current (transformed) 
label.  
 
This check was slow when a big model contained many *INCLUDE_TRANSFORM definitions, 
since it performed [#includes] * [#contents of model] checks. This has been recoded to make it 
more efficient so that in the best (and normal) case of no errors the time taken is now [#includes] 
+ [#contents of model]. It will become slower if errors are found, but this is quite unusual.  
 
The effect is to speed up Model Check, and also the pre-keyout check for this problem. 

• Case 37861 
Users on Windows could experience very slow keyword output speeds if writing files in 'native' 
mode on slow networks, or networks with a very high latency.  
 
This has been fixed by an internal change to how files are written to improve output buffering.  
 
In addition, the Windows | Unix | Native output format selector on the pre-output check panel 
(last stage before keyout) was wrongly greyed out if the model had no include files. This is now 
fixed. 

Parameter 

• Case 36755 
When reading or writing a model with 1000s of parameters with the same name, Primer can 
become very slow. This happened for example when there was a parameter in an include file 
which appeared 1000s of times in the model with different *INCLUDE_TRANSFORM 
statements. The speed of these operations has now been improved although the model is still a 
bit slower to process than models with the same number of parameters with different names. 

• Case 39987 
When editing the value of a character parameter on the top level editor, the Reset button became 
active, but clicking it would still have left the parameter with the new value. Now it correctly 
restores the old value. 

• Case 39011 
On the open-ended cards on *CONSTRAINED_SOIL_PILE parameters were sometimes 
replaced by their underlying values in PRIMER. Now the parameter references are kept 
correctly. 

• Case 38927 
In the *CONSTRAINED_INTERPOLATION edit panel, variables and would lose their 
parameter references after closing the panel. This has now been fixed. 

• Case 38644 
When typing a string with more than 70 characters without arithmetic operator into the edit panel 
for a parameter expression, PRIMER sometimes crashed or inserted empty lines in the 
expression. Now PRIMER rejects such a string with an error message because it cannot be a 
legal expression string. 
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• Case 38198 
Parameters were not handled correctly for CMO, CON1 and CON2 on 
*CONSTRAINED_NODAL_RIGID_BODY. This affected both read/copy/write and the edit 
panel and has now been fixed. 

• Case 37459 
Suppose you merge two models with a destination include such that:  

- the master model contains a _LOCAL parameter in the destination include and a 
parameter with the same name without _LOCAL,  

- the slave model has got a parameter with that name in its master file.  

If the value of the parameter in the slave model matches that of the global parameter in the 
master model, and the option 'Merge & rename' was selected, Primer sometimes attempted to 
merge the parameter in the slave model with the global parameter in the master model, and 
parameter references in the slave model would have been masked by the _LOCAL parameter 
from the master model, giving them a wrong value. Now Primer compares the _LOCAL 
parameter in the master model with that in the slave model when deciding whether or not to 
merge parameter definitions. 

• Case 37095 
When a *PARAMETER_DUPLICATION card with option 2 or 4 is present in the model, then 
LS-DYNA 'accepts' multiple definitions of the same parameter. In those cases PRIMER used the 
last definition for all references to that parameter and marked the other ones as ignored.  
 
It has now become clearer that LS-DYNA does not ignore all definitions except for the last one, 
but the parameter references are treated in the same way as if the parameter definitions had got a 
_MUTABLE suffix. For example, if there are two parameters with the same name and without 
_LOCAL suffix in the model, the parameter duplication options 2 and 4 say that references to 
that parameter name between the two definitions reference the first parameter definition, whereas 
references after the second definition reference the second definition.  
 
This is now how PRIMER handles these parameter duplication settings. On the edit panel, 
parameters which are treated as mutable due to duplication settings are now marked with a D 
symbol. 

Part replace 

• Case 39307 
Remesh area did not work properly if the part concerned was latent. This restriction has been 
removed. 

Part tree 

• Case 38456 
When undocking the part tree contents list table and expanding it, the newly visible button rows 
were only populated after moving the slider. Now they are populated immediately after resizing 
the table. 
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• Case 37618 
In Part Tree contents, *SENSOR_DEFINE and *SENSOR_SWITCH keywords were shown 
incorrectly. Fixed this. 

Pedestrian 

• Case 39428 
Head impact points for the GTR protocol could sometimes get duplicate labels. This has been 
fixed. 

• Case 39309 
The pedestrian markup tool could crash when writing out a csv file of impact points if the 
method for automatically creating head impact points was set to 'Nothing' and only manual 
points were created. This has been fixed. 

• Case 39054 
The semi-circular template used to join the rear reference line to the side reference line is now 
output to the model containing the reference sticks used to mark the vehicle. 

• Case 36973 
The way that the internal bumper reference line was calculated was incorrect in some 
circumstances.  
 
When projecting the stick contact point to the bumper beam it was not searching the whole 
profile of the beam as potential points to project to. This has been fixed. 

Penetrations 

• Case 39338 
The CT plot for contact penetrations has been improved so in the case where multiple nodes 
penetrate the same segment, the contour will correspond with the most penetrating. 

Preferences 

• Case 39672 
In the [Model] Read, Options panel one option is 'Save keyin log to file', and a possible setting 
for this is the directory to contain the keyword input log.  
 
This was getting saved as a preference by the 'Save keyword i/o settings' button, and would be 
read correctly when a new PRIMER session was started.  
 
However if [Options] Reread Primer Prefs was used it would not be reread. Now fixed. 

Program crash 
• Case 39887 
Primer could crash when merging a JavaScript with lots of include files if the include files did 
not have a trailing end-of-line character. Now fixed. 
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Program hanging 

• Case 39292 
If a model contained many thousands of *NODE_TRANSFORM definitions then PRIMER 
would take a very long time to read in the model and as no feedback was given to the user (s)he 
could think that PRIMER had crashed. This has been made significantly faster and feedback is 
now given to show the progress. 

Properties 
• Case 39864 
PRIMER no longer crashes when importing/exporting properties files if multiple models are 
loaded and one hasn't been selected. 

Read 

• Case 39579 
PRIMER crashed when reading a model that had the following characteristics:  

+ Duplicate control cards in separate include files.  
+ Those control cards used parameters.  

The crash was due to internal problems processing the 'clone' definitions in this particular 
situation. Now fixed. 

• Case 39463 
PRIMER would not give any warning messages or choices when reading duplicate 'static' 
entities (CONTROL or DATABASE cards) when included in an INCLUDE_TRANSFORM. 
This has been corrected. 

• Case 39366 
Now that PRIMER can write compressed files (.gz, .zip) and also files with binary format (.kby) 
the search for filenames generally and include files particularly must consider more than just the 
raw filename. The *INCLUDE statement in the parent file will always show the raw filename, 
typically .key, but the file on disk might be .kby, .key.gz, or a range of other permutations and 
PRIMER must search for all of these.  
 
This introduces the problem that if a file is modified and written out again to the same directory 
it may be in a different format, meaning for example that the directory has both filename.key and 
filename.key.gz, which raises the question 'which file should be read by PRIMER?'  
 
To solve this problem PRIMER now does the following:  

+ For the master file it looks for the verbatim filename as specified for input, and if this is 
found it uses that. Only if it is not found does it search for alternative syntax.  
 
+ For include files it always looks both for the verbatim filename and any alternative syntax.  
 
+ In both cases if the search turns up more than one candidate then a warning is printed to the 
dialogue box and the most recently modified file is read. 
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• Case 39003 
In very rare circumstances and 'undo' of edited data could go wrong, the exact criteria being:  

+ The same data must be edited and 'undone' twice in succession.  
+ The changed data must be the last item in the temporary 'undo' file.  
+ That data line must have two or more trailing fields containing zero  

This tripped an error that compression of data fields with trailing zeros got 'stuck' at its state 
when the first undo operation happened, and 'remembered' this during the second identical undo, 
causing data corruption.  
 
Fixed by removing any dependence on remembered data. 

• Case 38811 
PRIMER failed to read a 'long' (large) format deck in which a *SET_GENERAL card put the 
type code (here 'PART') in columns 11 to 20 of the first data field. The error was that it expected 
the type code to be in the first 10 columns, and did not consider long format.  
 
Fixed by making it consider the long format case correctly. 

• Case 37233 
The '.zip' file format allows the contents of an archive to be encrypted, and this caused problems 
in PRIMER which might hang when trying to read an encrypted file.  
 
In PRIMER v15.1 the hang has been fixed, but the file will not be read, instead aborting the file 
read with an error.  
 
In PRIMER 16 encryption is now detected, and the user will be prompted for a password so that 
the file can be read normally. Some minor changes to the way .zip files are read also means that 
PRIMER will be more likely to read an archive not written by itself in the first place. 

Renumber 

• Case 39625 
Reinstated formal names in Renumber includes summary and details information boxes. 

• Case 38942 
Fixed an error/crash that occurred when opening Model → Renumber → Visualise with a model 
containing only unlabelled and LATENT entities. 

Scripting 

• Case 36788 
When running lstc_dummy_file_read_script.js script, now PRIMER checks that there is 
information after the *END line. Otherwise a message is shown and the script is terminated. 

• Case 39889 
PRIMER's FMVSS201U script could fail the final model build step if the output csv filename 
contained spaces. This has now been fixed. 
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• Case 39616 
The beam to iges script only worked if the beams in each part were connected and the beam were 
labelled in the order they were connected. This limitation has been removed and the script now 
works with any model. 

• Case 39093 
FMH Script - Points 4, 7, M, 12, 14, 16 and 17 calculations have been improved, and new 
prompts have been added to prevent user error. 

• Case 39027 
SBA script - Issue with unit of the load is fixed. User has to specify correct load value in the 
given unit system.  
 
Loading beam was not aligned correctly which has been fixed now.  
 
Translation was not available if seat has beam. Now translation of forming is available for all the 
cases. 

• Case 38977 
Volume calc tool available in Primer didn't work correctly if user selected a part from models 
other than first model. The tool also fails if the section of the selected part is latent. Fixed both 
the problems. 

Seatsquash 

• Case 39206 
A crash occurred when setting up an LS-DYNA method seat-squash operation. This was due to 
the fact that the model contained a *SET_PART_ADD definition in which the option to define a 
range of labels using a -ve label was used, and the way this is stored internally caused an error in 
some circumstances.  
 
In fact, the error was due to removal of unwanted items from sets, and could have occurred 
during any process that performed the 'delete from set' internal operation where this -ve label 
option was used.  
 
This has now been fixed, but the fix involves leaving the -ve label intact in the set definition, i.e. 
leaving the designated range within the set 'as is'. Modellers wanting to control set contents 
precisely should probably avoid this syntax (and *SET_xxx_GENERAL) since it can lead to 
unintended consequences when model contents are manipulated. 

• Case 35033 
Parts which use *MAT_FABRIC where not being output to the dynain file when using the 
*INTERFACE_SPRINGBACK keyword in LS-DYNA R9.  
 
The DYNA seatsquash method in PRIMER uses *INTERFACE_SPRINGBACK, so running the 
model in an R9 version of LS-DYNA meant that the nodal coordinates of *MAT_FABRIC parts 
could not be imported back into the model.  
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A new option has been added to the seatsquash menu to use 
*DEFINE_CONSTRUCTION_STAGES instead, which does output *MAT_FABRIC parts. The 
*INTERFACE_SPRINGBACK method is still the default (for backwards compatibility), but it 
can be changed with the preference primer*squash_use_define_construction.  
 
In addition, a check has been added when writing out a model which will issue a warning if the 
LS-DYNA version is set to R9 and any part in the *INTERFACE_SPRINGBACK set uses 
*MAT_FABRIC. 

Sections 

• Case 37995 
*SECTION_SOLID_{OPTION} is now included in the keyword editor 

Selection 

• Case 39709 
If you were editing a set for a nodal rigid body and using the 'hole' option in the object menu to 
add nodes to the set, then it would not work if any of the nodes on the hole were already in the 
set. Now fixed. 

• Case 39261 
The user interface could get 'locked out' in the following situation:  

- 'Show ambiguous' was turned on for ambiguous screen picks  
- Such a pick took place near the very top or right hand side borders of the master 

PRIMER window.  

The 'list of ambiguous items' popup would try to map itself partially outside the confines of the 
master window, causing an error and a failure to be drawn. However, since the UI locks input to 
this window there was no way for the user to cancel it, resulting in lock out.  
 
Fixed by clamping the position of that popup to lie within the bounds of the window. 

• Case 38182 
Selecting certain element types that have a long list of nodes (e.g. 
ELEMENT_SHELL_NURBS_PATCH) by left clicking and dragging in the graphics window 
could corrupt PRIMER, with unknown consequences. This has been fixed. 

Sets 

• Case 37359 
Removing segments from a set by direct selection (e.g.by screen area) worked OK but selection 
by the feature line method on the object menu failed to remove them. The segments in a set 
under edit are actually scratch definitions so some extra work is required to enable this selection 
method. Now fixed. 
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Shortcut 

• Case 37521 
Keyboard shortcut preferences in PRIMER did not consider the 'Clear' setting for any of the 
keys. Now the 'Clear' settings for any of the keys will be added into Preferences as an Empty 
string. 

Text Editor 

• Case 38696 
On Windows 10 we have observed that using the Notepad++ editor for 'text edit' can cause 
problems as follows:  

+ User opens a PRIMER editing panel, then uses 'text edit' to inspect the card in detail.  
 
+ External text editor is closed, with or without changes.  
 
+ Shortly afterwards user tries to re-open the card in the text editor, and is told that it is 
still being edited.  
 
+ After some period of time, usually less than a minute, this problem seems to resolve 
itself and the card becomes editable again.  

We have traced this problem to something in the way Windows opens and closes files using 
Notepad++, and in particular it seems that sometimes Notepad++ will 'hang onto' the file for up 
to a minute even though it is closed. The cause is unknown, and appears to be a Windows 10 
gremlin, but there are various workarounds:  

(1) Modify the default arguments to open Notepad++ using the following PRIMER 
preference:  
primer*text_editor: 'C:\Program Files (x86)\Notepad++\notepad++.exe' -multiInst -
notabbar -nosession  
 

(2) Use a different text editor, eg wordpad, vim, etc. These can be defined using the same 
'primer*text_editor' preference. 

Transform 

• Case 39516 
If a keyword file contained a *NODE_TRANSFORM definition inside an 
*INCLUDE_TRANSFORM and PRIMER wrote a merged keyword file, the merged file would 
be incorrect. Now fixed. 

• Case 37579 
NODE_TRANSFORM cannot be used with SET_COLLECT. This error is now trapped in 
Primer and an error message is given. 
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Undo 

• Case 38032 
'Undo' of deletion of *AIRBAG_REFERENCE_GEOMETRY and 
*AIRBAG_SHELL_REFERENCE_GEOMETRY definitions on nodes and elements was not 
working correctly. When a *NODE card that has airbag reference geometry is deleted special 
measures have to be taken to preserve that extra geometry for 'restore after undo', and these were 
not working correctly. The same applied to *AIRBAG_SHELL_REFERENCE_GEOMETRY 
when the shell in question was deleted, and the deletion was then 'undone'.  
 
These problems are now fixed. 

User interface 

• Case 39626 
Upon clicking on 'Contact' in the 'Connection' panel, all of the buttons on this panel would shift 
down leaving some empty grey space at the top of the panel. This has now been fixed. 

• Case 39184 
Popups no longer appear on the main menu > Volume III keyword buttons where they should 
not. 

• Case 38943 
Delete recursive and Remove from sets buttons are now mapped on the *AIRBAG top level 
panel. 

Volume 3 
• Case 39778 
The keyword *EM_CIRCUIT seems to need a new header for each circuit defined. 

• Case 39725 
In the LS-DYNA manual, *EM_EXTERNAL_FIELD is defined as a float, hence PRIMER was 
storing and writing this field as a float. However, the field's description suggests that it should be 
stored as an integer. Also, when a float is read in to LS-PP for this field, LS-PP returns errors. 
Therefore, has been changed to be stored and written as a integer in PRIMER. 

Write 

• Case 38384 
A new option has been added to the PTF/d3plot writer in PRIMER. You can now force it to 
write a file that will have data slots available for writing data to multiple on plan points on Shells 
and Thick Shells.  
 
This can be useful if you want to create a JavaScript UBIN component and write data to on plan 
points.  
 
(If the model contains *INITIAL_STRESS_(T)SHELL cards with on plan points, PRIMER will 
automatically create a file with slots for this data, and the option is not required in this case.) 
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• Case 37702 
Headers are now written for all *DEFINE_ADAPTIVE_SOLID_TO_SPH and 
*DEFINE_ADAPTIVE_SOLID_TO_SPH_ID keywords. 

• Case 37402 
LS-Dyna expects all the *EM_EOS_XXX keywords should be keyed-out under separate 
headers, PRIMER was outputting all instances of same type of keywords under one header. 
Fixed this. 

 

Xref 

• Case 38424 
In some of the edit panels 'View Xrefs' button was not active if the entity is not referred by 
anything. The panels are changed such that the 'View Xrefs' button is always active. 
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2.2 D3PLOT 

2.2.1 Bugs Fixed in 16.0 

Blanking 

• Case 39649 
If a contact model (.ctf) is loaded without the Interface force segments and data option selected, 
the model only reads in nodes. In this case, if the user changed to the old blank menu, D3PLOT 
hung. This has been fixed. 

• Case 39586 
In the Blanking Menu D3PLOT could show incorrect list of selected parts when selecting from 
the screen and then deselecting some parts. The parts highlighted on the screen and the parts 
blanked were correct. This has been fixed. 

Contour 

• Case 39258 
If a PR plot was generated when enveloping was on, incorrect results were shown. In D3PLOT 
v16.0 PR plotting has been disabled when enveloping is on to prevent this. 

Component 

• Case 37458 
In D3PLOT v16.0 if the shell surface is set to MIN, MAX and MAG this also considers the mid-
surface value for shell elements with an even number of through-thickness integration points. 
In previous versions of D3PLOT, MAX, MIN or MAG only looked across values at the shell 
through-thickness integration points. If a shell has an even number of through-thickness 
integration points there is not an integration point at the mid-surface. Previous versions of 
D3PLOT did not consider the computed mid-surface value (which could be separately plotted by 
selecting MIDDLE in the surface menu) in calculating MIN, MAX or MAG. For such cases, and 
for some components, the MIDDLE value could be, for example, lower than the MIN value.  

Data components 

• Case 38790 
In the particular case of [magnified displacements] and [reference state] and [32 bit data file] 
D3PLOT would draw the current geometry without any displacement for the current state. The 
calculation of displacements for plotting, Write and XY data were not affected.  
 
This error was introduced into D3PLOT v15.0 when the double precision (64 bit data file) 
calculation was added, it has been fixed in D3PLOT v16.0 onwards. 

Dialogue command 

• Case 39458 
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The dialogue command line option to set the number of contour levels would only allow up to 13 
levels to be defined. This had been changed to allow up to 16 levels. 

Filename 

• Case 39940 
On Linux if you ask to create database, and use the file selector to create a new file, it would 
give an error message 'File not found'. This is now fixed, and you can create a new file.  

General 

• Case 39407 
When calculating a nodal trace D3PLOT would not respond to the STOP button. This has been 
fixed. 

Graphics 

• Case 38768 
If the overlay mode for Beam parts was changed to 'No Overlay' using the Quick Pick option the 
overlay was still drawn using all edges. This has been fixed. 

• Case 38611 
On some remote Linux servers running VirtualGL the D3PLOT executable would refuse to start 
giving an error message saying 'Cannot get OpenGL rendering context'. This was caused by an 
incompatibility between the server and the way D3PLOT was trying to open the OpenGL 
graphics window. It has been fixed in D3PLOT v16.0 onwards. 

Groups 

• Case 39273 
D3PLOT v15.0 would fail to read any binary group files (*.grp) generated by v15.0 or v14.0. 
Binary group files (*.grp) generated by older versions could be read. This has been fixed. 
D3PLOT v16.0 can read binary group files (*.grp) generated by all versions. 

JavaScript API 

• Case 37661 
If the JavaScript functions IsBlanked(), Blank() or Unblank() were used when 
multiple models were loaded into D3PLOT the functions could check or set the blanking status 
in the wrong model even if SetCurrentModel(model_id) was called first. This has been 
fixed. 

• Case 37078 
GetData generated an error message for SPC_F and SPC_M. This has been fixed and 
GetData now extracts the data for these components. 
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Measure 

• Case 39359 
For a part part-part measure with multiple parts, if screen picking was used to select a part, the 
part could end up on both sides of the measure. Now when the user does this, the part is removed 
from the other side of the measure. 

• Case 36235 
In D3PLOT v16.0 it is now possible to pick nodes in a volume 3 domain (CESE, ICFD etc) 
within the measure menu. 

Menus 

• Case 39688 
When using Quick Find to 'Open New Model', an extra carriage return keystroke could cause 
D3PLOT to lock up. This has been fixed. 

• Case 39657 
In version 15.1 some of the buttons in the Edit Window menu were not drawn correctly if you 
moved the mouse over a button with a popup menu attached to them. 

• Case 39457 
If the new style object menus were used to select things by screen area and the area selected by 
the user was of zero size (they had picked coincident points) then they could end up being locked 
out of all the other menus in D3PLOT (an X would appear if you moved the mouse).  This has 
been fixed. 

• Case 38920 
In the 'DATA' menu under 'Min/Max Options', the 'Export to Write' option mapped the 'WRITE' 
menu as well as the Write Table, and the 'Export to XY Data' mapped the 'XY-DATA' menu as 
well as the XY Graph.  
 
In D3PLOT v16.0 only the Write Table or the X-Y Graph are mapped and the right hand menu 
remains showing the 'DATA' menu with 'Min/Max Options' . 

Metal forming 

• Case 37190 
In D3PLOT v16.0 the FLD plotting panel is now unmapped and reset when a new model is 
loaded. This is consistent with other menus in D3PLOT like WRITE and XY-DATA. 
Previously if you had an FLD plot open showing data for M1 and then you opened a new model 
(M2) the FLD plot options panel updated with model tabs and M2 was automatically selected. If 
you then closed M2, the FLD plot closed, even though valid data remained for M1.  

Output 

• Case 37561 
D3PLOT could crash if it read in a PTF file (d3plot) or d3eigv file created by a model containing 
the *DATABASE_EXTENT_BINARY_COMP card. This crash was caused by this card 
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modifying some of the values in the ptf and d3eigv files and D3PLOT did not know about these 
modified values. This has been fixed in D3PLOT v16.0. 

Properties 

• Case 39932 
On Linux D3PLOT would fail to read in a properties file that had been written on a Windows 
PC. This has been fixed. 

• Case 39302 
There are read errors if a properties file contains a very long filename in the $ File comment (in 
excess of 230 characters). In D3PLOT v16.0 property files are written with very long filenames 
split over multiple comment lines. 

• Case 39186 
When using multiple properties files in D3PLOT once items were blanked they would not re-
appear if a later properties file un-blanked them.  This caused problems with child objects in 
REPORTER.  This has been fixed. 

• Case 39021 
If contact surfaces (or parts of them) were blanked and the blanking status was saved to a 
properties file, the blanking status was not correctly set when the properties file was reloaded. 
This has been fixed. 

Quick pick 

• Case 38658 
D3PLOT would crash the user tried to select a set using Quick Pick with generic 'Sets' rather 
than one of the specific set types.  This is if a model contained set definitions (read from the ZTF 
file).  In D3PLOT v16.0 for Quick Picks users can are now restricted to choosing the entity type 
to be one of the specific set types. 

Read 

• Case 40026 
If you used the File->FAM_SIZE popup to change the maximum file size for family members, 
D3PLOT would crash. It no longer crashes. 

• Case 39978 
Previously PrePost .db files had 'Hz' appended to the state timestep, e.g. '0.15 Hz'. The 'Hz' has 
been removed. 

• Case 39256 
Due to an internal change in the data written to the D3RMS file by newer versions of LS-DYNA, 
D3PLOT would read the D3RMS file but not display the geometry correctly. D3PLOT v16.0 has 
been modified to automatically detect the two different file formats and supports both old and 
new D3RMS files. 
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• Case 38603 
Previously if D3PLOT detected a file which contained corrupt element topologies it would 
refuse to read the file. In D3PLOT v16.0 this has been changed so that D3PLOT now 
automatically substitutes node 1 for any invalid nodes and continues so that the file can still be 
processed and read into D3PLOT. If any elements are detected with corrupt topologies a warning 
message (including the number of elements) is written to the dialogue window. 

Variables 

• Case 38513 
To export variables to REPORTER, the Variables panel need not be closed for variables to save 
to a capture when Capture or Update is pressed. 

Volume 3 

• Case 39472 
D3PLOT would crash if a Vector plot of an EMAG Surface data component was plotted. This 
has been fixed. Plotting the magnitude of the same data component as a CT or SI plot already 
worked correctly. 

• Case 39471 
The shortcut key 'R' to reverse the blanking status of everything did not process EMAG surface 
elements correctly, and their blanking status was not set correctly. This has been fixed. 
Blanking EMAG surface elements using the BLANK menu already worked correctly. 

• Case 39459 
Volume 3 vector plots on solid elements caused D3PLOT v15.0 and v15.1 to crash. This bug has 
been fixed. 

• Case 36234 
In D3PLOT v16.0 the WRITE menu now supports Volume 3 elements and data components. In 
D3PLOT v15.0 and v15.1 Volume 3 elements could be selected, but an error message was 
displayed as no data components were supported. 

Write 

• Case 39939 
If the WRITE table was undocked on LINUX it could disappear behind other application 
windows when a popup menu attached to any of the buttons in the WRITE table was mapped. 

• Case 39179 
If a command file was recorded that used any of the new style object menus (WRITE, BLANK, 
XY-DATA) then it would not play back in 'batch' mode and would sometimes fail if run 
interactively if there had been any changes to the model.  
This is fixed in D3PLOT v16.0 so command files can be written and read in batch mode. 
Unfortunately this change is not backwards compatible and any command files recorded in 
versions 14 or 15 that use these menus will not work in v16.0. 
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• Case 38973 
If the WRITE Keyword option was used to export element information in Keyword format, then 
elements that had failed and been deleted were included. In D3PLOT v16.0 these elements are 
excluded by default and a new option to include failed elements has been added to the menu. 

• Case 38699 
Models with multiple IP solid results that were read in without a ZTF file would show the first IP 
value in the write table, but plot contours with a value based on the preference 
d3plot*multi_ip_mode. This has been corrected, so the Write Table now shows the same 
value as the contour plot, i.e. based on the preference d3plot*multi_ip_mode.  
 
Shell elements with multiple on-plan IP results but no ZTF file would show the first IP value on 
both contour plots and in the Write Table. This has been changed, so that in both cases the value 
shown is based on the preference d3plot*multi_ip_mode. 

XY Data 

• Case 39668 
In D3PLOT v16.0 the plotting of XY data has been sped up for plotting a large number of 
entities across a lot of states. 

• Case 38138 
In D3PLOT v16.0 partial state selection across multiple windows works properly. Previously 
you had to have some states selected in the first active window or some menu options would be 
greyed out.  Under 'List selected' D3PLOT v16.0 lists the #states in each active window, rather 
than just the first active window. 

• Case 37549 
For XY Data when using “composite data” and “state selection by time”, there could be extra 
empty curves created with corresponding error messages. In D3PLOT v16.0 these curves are not 
created. 

• Case 37505 
In the XY Data menu for “state selection by time”, if a very small time interval was specified, 
D3PLOT could hang. In D3PLOT v16.0 this has been fixed and there is a (model dependent0 
minimal value for the time interval. 
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2.3 T/HIS 

2.3.1 Bugs Fixed in 16.0 

Curve menu 

• Case 39279 
If the curve manager was undocked and made wider than the curve label, buttons 
always expanded to take up the full width available so as much of the curve label as 
possible could be displayed.  
 
If, when the curve manager was docked, the right-hand menus were made wider then 
up to a certain point, the curve label buttons adjusted themselves to use all the 
available space. Eventually they reached a maximum after which if the panel is made 
any wider you ended up with unused space on the right.  
 
This has been fixed in 16.0 

Curves 

• Case 39775 
Fixed an issue where 'Sort by Name' would give curves an incorrect label. 

Datum 

• Case 38605 
When a Y2-datum line was created, thus adding a Y2-axis if it was not there before, 
the Y2-axis buttons next to each curve in the curve manager were not displayed. This 
has been fixed in V16.0. 

Dialogue command 

• Case 39706 
The manual stated that the command used to read PART GROUP data was 'P_G', 
however this did not work. Now 'P_G', 'P_' and 'PG' will all work. 

• Case 39015 
The global command 'Clear' and corresponding command 'CL' have been removed, 
they were previously replaced by the shortcut key 'b' and no longer did anything. The 
command 'GRO' was not working, it now does the same as 'PGR'. The commands 
GRAPH > MAP/UNMAP have also been removed from T/HIS. 
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FAST-TCF 

• Case 39285 
T/HIS could crash when generating a FAST-TCF script if any of the curves that were 
being captured in the script had been generated using the 'Window' curve operation. 

• Case 38746 
A FAST-TCF tag is attached to each curve generated through JavaScript. We can now 
use the curves generated in a JavaScript inside FAST-TCF. 

Graphs 

• Case 38119 
When an axis is displayed with logscale turned on, the format of the values can now 
be changed with the 'Automatic', 'General' and 'Scientific' options. 

• Case 38912 
The FAST-TCF command  
layout page 'n' graph 'm' position x,y, x,y  
didn't update a graph’s position correctly if graphs were only present on a single page. 
This has been fixed. 

Integration 

• Case 40032 
The T/HIS->PRIMER link auto-locates a keyword deck by looking for either a .thf 
file or an .xtf file and then searching for a .key file with the same name (minus 
extension). There was an issue in previous versions that meant that T/HIS was, in fact, 
looking for a .thf file a second time (instead of a .xtf) if the first search failed. This has 
been fixed. 

JavaScript API 

• Case 39842 
If a T/HIS JavaScript was created that used Windows and Widgets then the JavaScript 
would not run in T/HIS if T/HIS was being run as part of the D3PLOT>T/HIS link. 

• Case 39014 
Users can now update the curve unit system through the curve member property 
'unit_system'. 

• Case 38747 
Curve tags assigned from inside a JavaScript didn't appear in the curve manager. This 
has been fixed. 
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• Case 38735 
The JavaScript function Operate.Rs previously returned a single curve rather than the 
expected array of 5 output curves. This has been fixed. 

• Case 38681 
The pure Butterworth filter operation 'Pbut' in the JavaScript API, did not work 
correctly as the input arguments were not being read in properly. This has been fixed. 

Licensing 

• Case 39492 
In version 15.0/15.1 a popup window was displayed when the software started if the 
license expired in less than 31 days. When this message was displayed the window 
included the following: 
 
You can disable this message by setting the preference option:  
 
*show_license_warning: FALSE  
 
If this preference was set then the message was not displayed in D3PLOT but this 
preference did not work in either T/HIS or PRIMER. 
 
This has been fixed in V16.0 and the preference is now applied correctly in all three 
programs.  
 

LSDA (binout) 

• Case 39089 
T/HIS could fail to read data for some entities from the BNDOUT data in an LSDA 
(binout) file generated by the R11 release of LS-DYNA.  
 
This problem was caused by a change to the internal file structure of the LSDA file in 
R11. 
This has been fixed. 

• Case 33220 
If SSD or PSD data was present in a model, but also a THF file existed containing the 
data for the initial state, then previously only the THF was read and not the SSD or 
PSD data. This has been fixed so that if SSD or PSD data is present, then data for 
relevant entity types is always read from the binout file, even if a THF file exists. 
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Menus 

• Case 37429 
The Curves menu 'Blank' > 'Pick Visible' menu was not dismissing Picking after 
dismissing the menu. This has now been fixed. 

Operations 

• Case 38956 
If the COMbine operation was used with 2 groups of curves each containing multiple 
curves then the output from some of the combine operations could be wrong if the 
pairs of curves didn't contain matching X-axis values. This has been fixed. 

• Case 38732 
Curve legend for the MAP operation will now be based on the second curve. 

• Case 38305 
The seismic response spectrum function (RS) was inaccurate for small regularization 
intervals. This has been fixed. 

• Case 37518 
Any checks relating to the maximum number of points on a curve have been removed 
and replaced with warning messages together with optional user termination in case a 
large number of points causes an operation to run slowly. 

Read 

• Case 39678 
In some dialogue box read and write commands, such as for .cur files, spaces in 
filenames could cause the command to be processed incorrectly. This has been fixed. 

• Case 39417 
If the number of curves in a CSV file was changed after the file was first selected in 
the Read panel, then previously the CSV file was not always read correctly. This has 
been fixed. 

• Case 39133 
T/HIS could crash if rotational data components were read from the ASCII NODOUT 
file using a JavaScript. This has been fixed. 

• Case 38940 
T/HIS would crash if curves were read from a KEYWORD input file using the 
dialogue command: 
 
/read kw filename  
 
if the filename specified didn't include a path. This has been fixed. 
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• Case 37502 
Data for Part 0 and Part -1 in ASCII matsum files, which occurs if there is non-
structural kinetic energy in the model, is now summed and read into the global data 
component Lumped Kinetic Energy (LKE). This is consistent with LSDA binout files, 
which contain "lumped_kinetic_energy" data that corresponds to what would be the 
sum of Part 0 and Part -1 data from an ASCII matsum file. 

Write 

• Case 39016 
If no model or display unit system was present, when a cur file containing a unit 
system was read in and written out, there would be no units written to the file. This 
has been fixed, the cur file will now contain the curve units in this case. 
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2.4 REPORTER 

2.4.1 Bugs Fixed in 16.0 

Filename 

• Case 39303 
When editing a variable of type ‘Directory’, if ‘Browse…’ was clicked to browse for 
a directory with a UNC path (e.g. \\example.com\data\analysis\001), the value 
returned would contain forward slashes (//example.com/data/analysis/001). 
Backslashes are now preserved. 

Image 
• Case 38792 
PNG images with transparency would appear white in PDF output. Now fixed. 

JavaScript API 

• Case 38772 
The red, green, blue and name properties in the Colour class did not work.  
When getting the property null would be returned instead of the correct value.  
Now fixed. 

Library 

• Case 38711 
When running on Linux a warning ‘libpng warning: iCCP: known incorrect sRGB 
profile’ would be written to stdout. Now fixed. 

Variables 

• Case 38791 
After a PRIMER, D3PLOT or T/HIS capture, the special read-only variables (e.g. 
REPORTER_TEMP) were being set as writeable, meaning that they would be 
mistakenly written to the template/report file if it was subsequently saved. 
Furthermore, after a capture, all variables were being changed to temporary variables. 
Both now fixed. 

• Case 38513 
To export variables to REPORTER, the Variables panel need not be closed for 
variables to save to a capture when Capture or Update is pressed. 
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Properties 

• Case 39186 
When using multiple properties files in D3PLOT once items were blanked they would 
not re-appear if a later properties file un-blanked them.  This caused problems with 
child objects in REPORTER.  This has been fixed.  
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2.5 SHELL 

2.5.1 Bugs fixed in 16.0 

Menus 

• Case 37585 
The DISPLAY textbox was not getting updated in the LS-DYNA Submission panel. This is now 
fixed. 

• Case 37383 
Previously, the text in one of the popup buttons off the 'Manual' link in the SHELL main window 
could be obscured by its thumbnail. This has been fixed. 

Manual 

• Case 37437 
There was a correction in the manual. The Environment variable name should be 
LSTC_INTERNAL_CLIENT, not LSTC_NOCLIENT.  
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3 Enhancements 
The enhancements and bug-fixes for each program have been broken down into a series of 
topics.  Within each topic enhancements and bug-fixes are listed by case ID. 

3.1 PRIMER 

3.1.1 Enhancements in Version 16.0 

Checking 

• Case 39227 
The DYNA output tree can now show the 100 smallest timestep messages from DYNA output 
files. 

• Case 38294 
Checks are added for EDGSET in SECTION  
1) Error is shown if Part referrenced by nodes in EDGSET does not match the part that refers the 
section in seatbelt.  
2) Error is shown if nodes in EDGESET are not on a free edge. 

• Case 37694 
By default, DYNA output check now searches for *.otf, *.prt, d3hsp, *.d3hsp, mes*, and *.mes*. 
An optional additional search has been added in which the user can specify the search criteria. 
This can include wildcards: '?' - represents one character, '*' - represents any number of 
characters. e.g. filename_??.* would find: filename_01.mes0000, filename_01.d3hsp, 
filename_01.otf, filename_01.prt, etc. 

• Case 37631 
Added the option for DYNA output check to search for, and read, DYNA output files 
compressed as .gz or .zip files. This option can be set under the preference 
primer*compressed_dyna_output_search:TRUE. 

• Case 36753 
Two new element quality checks have been added: Taper check and Tetra collapse check.  
 
These checks can be performed via Check and displayed as CT/SI plots, as well as being printed 
out in a summary file. The checks have been added to the 'Element Quality' and 'Failed Criteria' 
CT/SI plots.  
 
The Taper and Tet Collapse functions can also be called using the API. 

Connections 

• Case 37728 
NRB bolt connections made across include files now by default use SET_NODE_COLLECT. 
There is a preference to revert this to the original behaviour (SET_NODE_LIST). 
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• Case 34409 
Added a new column in connections table to output Hex Assembly 
(*DEFINE_HEX_SPOTWELD_ASSEMBLY) labels for spot-weld connections. 

Contour 

• Case 38377 
A new JavaScript function has been added to plot contours:  
 
For example: View.SetContourType(View.ELEMPROPS, View.FORMULATION); 

• Case 34712 
Ability to contour shells depending on the direction of the shell loads (Away, Towards, Both, 
None) 

• Case 31909 
New contouring options under Shell thickness: % thinning and % remaining which report the 
change in section on *ELEMENT_SHELL_THICKNESS from the dynain file 

Dummies 
• Case 37741 
Multi stage positioning option for combined seatsquash and dummy positioning has been added. 
It will allow users to add multiple intermediate positions for dummy position and seat squash.  
 
Added a tick box option next to each intermediate positions to write out dynain file for each 
intermediate stage during DYNA run by creating *DEFINE_CONSTRUCTION_STAGES cards 
for each intermediate position.  
 
Command line support has also been added. 

Edit 

• Case 39283 
*DEFORMABLE_TO_RIGID support in PRIMER has been improved in the following ways:  

• There is now a keyword editor for all _AUTOMATIC suffix. This editor only shows the 
top two fixed rows of data, but it makes it possible to adjust values such as TIME in bulk. 
(The open-ended listing of D2R and R2D data can still be edited in the existing scalar 
editor.)  
 

• Graphics of all sub-types of this keyword is now implemented fully. Previously it was 
only possible to 'sketch' them, or to perform a half-hearted 'Only' operation by showing 
parts. 'Only', 'Find', etc now all work properly.  
 

• This also means that screen selection is also now fully implemented.  
 

• In selection menus the distinction between the labelled _AUTOMATIC suffix and the 
other unlabelled suffices is now made where relevant. This means that where a labelled 
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_AUTOMATIC type needs to be selected it should no longer be possible to select the 
wrong type, which was possible before because the menu lists show PRIMER's internally 
allocated labels for those types. 

Graphics 
• Case 38239 
Added visualisation of normal vector for RIGIDWALLs. 

• Case 34594 
Additional option in View→Contour plots→Shell normals→Vector which shows Shell elements 
normal direction as arrows. The same feature is also added in ELEMENT→Shell→ 
Align/Normal panel when 'Draw Normals' button is active. 

• Case 34337 
SPR. SPR2 and SPR3 can now be visualized. Primer calculates the points on each sheet using 
the spot-welder tool and draws large red blob to mark the master panel - the head of the rivet and 
smaller green blobs to mark the other sheets. 

Iga 

• Case 35364 
Primer can now display iso-geometric surfaces defined with the keyword 
*ELEMENT_SHELL_NURBS_PATCH. Spot-weld connections can also be made between them 
and other shells/solid elements. 

Image 

• Case 39153 
PRIMER 16.0 introduces the following changes to the handling of output image filenames:  

- If an explicit filename (optionally, with path) is typed in or selected for one image type, 
say JPEG, that new filename and path will then become a seed for every image type. 
Changing to a different image type, say PNG, will not require users to browse to the user-
defined path again. Instead the new seed name will be used for the PNG file with the 
appropriate extension (.png) and a unique increment added if needed.  
 
- Extensions that are an obvious mismatch will be auto-corrected and a warning issued. 
For example, if a user attempts to write out a BMP with the filename myfile.gif, the 
filename will be changed to myfile.bmp automatically. The filename myfile.image will, 
however, not be auto-corrected.  
 
- If a user-chosen filename exists, clicking the NEW_FILE option will not take the user 
back to the current working directory as was done in the past. Instead, a unique 3 digit 
increment will be appended to the same name to generate a new filename.  
 
- A sub-folder (one level only) is now also automatically created as a part of image 
creation, if needed.  
 
- All of the above now also applies to postscript files (PS and PDF), although the 
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handling of images and postscript files is kept disparate. So, choosing a new image name 
will not alter the default filename for movie or postscript files. Choosing a new postscript 
filename will, however, update the default filename for pdfs. 

Include transform 
• Case 37872 
User can now pick nodes on multiple models if he/she chooses POS6P in 
DEFINE_TRANSFORM. Otherwise, Picking on multiple models is not allowed 

Javascript api 

• Case 38780 
New interface keywords have been added to API:  

• Interface Component  
• Interface Linking edge 

• Case 38700 
The object returned from the Dummy GetPoint() method now includes a <hpt> property that is 
true if the point has been automatically generated by PRIMER at the H-point. 

• Case 35220 
Added JavaScript API FlagVisible() in PART class to flag unblanked parts in the model. 

Keyword 

• Case 37848 
Node Coordinates (X,Y,Z) are displayed after user picks single node NID (and then ADD) in 
BOUNDARY→ PRESCRIBED FINAL GEOMETRY 

Mass 

• Case 37082 
Optional control over the part CentreOfGravity calculation has been added to the javascript API. 
The settings given below are the defaults that would apply if no option was given. 

  
var cofg = p.CentreOfGravity({slaveparts:true, transfermass:true, lumpedmass:false, 
nrbmass:false, timestepmass:false, plot:false});  
 
You can now e.g. remove Rigid Body merges by setting “slaveparts:false” or include attached 
nrbs by “nrbmass:true” 
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Menus 

• Case 37423 
Various text suggestions are added in quick search  
Import, open for model read  
Export, save, close for model write  
Connector for connection panel  
Mask for entity panel  
Align node for orient project to line  
Find attached for attached  
equivalence node for node merge panel  
snapshot for capturing images 

Mesh 

• Case 38549 
Shell element can be split in 3x3 way using Mesh tools → Split. 

• Case 37460 
Introduced a new parameter R1 for the swages creation panel to create swages mesh with 'Dome' 
like TOP surface and also to smoothen the SIDE surfaces of the swage. 

Model build 

• Case 33089 
Added recent files selection popup menu for model build database file input. 

Morphing 

• Case 39316 
Added new [Advanced Options] button on the Morph Tab for MORPH tool. 

• Case 37738 
In PRIMER 15 morph boxes have got 2 by 2 by 2 morph points at the corners of a cuboid. When 
morphing is applied, nodal coordinates are recalculated linearly in each parametric coordinate 
direction.  
 
In PRIMER 16 this has been generalised to morph boxes with more morph points. In their 
original position they are still in a grid of cuboids. When morphing is applied, the nodal 
coordinates are recalculated using higher degree Bernstein polynomials in each coordinate 
direction. In other words, the calculation of the nodal coordinates is that of a 3-dimensional 
NURBS patch where the control points are the positions of the morph points.  
 
There are also visibility switches to turn on and off corner, edge, face and internal morph points. 
There are also different options what morph points are interpolated when a given selection is 
dragged. 
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• Case 37734 
Added new JavaScript API classes MorphPoint and MorphBox to allow access to the morphing 
functions in PRIMER. 

• Case 37042 
There are the following morphing additions in PRIMER 16:  
 
On the Morph panel there is now a Utilities tab where morph boxes can be directly reset or 
deleted.  
 
When morph points are dragged interactively or by selection, the current drag vector is 
dynamically displayed on the panel. It is now also possible to type in a vector to apply that 
morphing to the selection. This is useful for morphing on parts which should remain symmetric 
and where the same distance should be applied to different morph points (possibly in a different 
direction but the same distance). In PRIMER 15 there was already the option to type in an offset 
distance, but this was only available in selection mode and when a drag direction X, Y or Z was 
specified, but not for the drag directions Free and Mouse, which are most flexible and used more 
often. The offset vector text box in PRIMER 16 therefore needs fewer clicks. 

• Case 36355 
PRIMER can now apply morphing from command line arguments, which is in particular useful 
for optimisations with LS-OPT. The following has been added for this purpose:  
 
- A post-*END keyword *MORPH_FLOW assigning vectors to morph points. The idea of this is 
that applying a variable value moves each morph point on the morph flow by that vector 
multiplied by the variable value, allowing morphing to be parametrised. Morph flows can be 
created and edited interactively or in the JavaScript API.  
- A JSON variable file format: This lists variable names and values, which will be applied to the 
morph flow definitions.  
- A new command line option -ls_opt= specifying the variable file name on the command, so 
PRIMER can apply morphing when it starts.  
 
More detail about this can be found in the PRIMER manual and in the tutorial about morphing 
optimisation. 

Nastran 

• Case 39083 
The default method for conversion of Dyna tied contact to Nastran RBE3 has been modified so 
that DOF=123456 (rotation constraint) formulation is no longer used for nodes that align to 
segment edges. Instead we use DOF=123 with very small weight factors for the uninvolved 
nodes. A switch [RBE3 with 2 indep nodes] permits reversion to the original behaviour, should 
users want it 

Orient 

• Case 38481 
A contact thickness option has been added to contact orient which will over-rule the physical 
thicknesses of the parts when depenetrating or bringing to the point of contact. 
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• Case 38234 
Orient tool now has option to translate by defined VECTORs. 

• Case 37739 
'add_gap' parameter is used in orient using contact feature. This option has now been added to 
dialogue command. 

Part table 
• Case 38395 
Added support for CPARM8 on *PART_CONTACT on part table as new column. 

Preferences 

• Case 39260 
'Text edit pref' has been added to the options drop-down. If user has permission to access the 
install directory, (s)he will be give choice of home or install preference file, otherwise the home 
preference file is opened. 

• Case 35344 
All settings in the main 'Keyword i/o options' panel can be saved via the new button 'Save 
Keyword i/o options', except for customised selections of 'Permit duplicate definitions'. New 
preferences have been added to account for the options that previously could not be saved as a 
preference. These are:  
 
force_keyword_format  
input_exception_BOUNDARY  
input_exception_INITIAL  
input_exception_LOAD  
large_format_80cols  
preread_parameters  
single_card_ABAG  
single_card_EQOS  
single_card_HGLS  
single_card_MATL  
 
All of which can also be set via the edit preferences panel. 

Renumber 
• Case 38859 
Added [FIX CLASH & POST RENUMBER] option for label clashes when adding or replacing 
INCLUDE files. 

Rigidify 

• Case 38012 
CMO, CON1 and CON2 fields are added on Rigidify Panel. 
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Scripting 

• Case 39101 
FMH Script  

• Added grid lines for all planes to help with visualisation.  
• Added display of UR boundaries for RP1 visualisation.  
• Corrected FH1 and FH2 reference image, as well as improved RP2 reference image. 

• Case 39094 
FMH Script:  

• Improved GUI by changing to non-modal and adding settings options 
• Allowed impact point calculations for models with latent parts.  
• Added macro tags to check boxes, text boxes and buttons. 

• Case 39026 
Now user can control belt stiffness ratio between loading belt and the belt itself. Default belt 
stiffness ratio is set to 10. The option is available in the setting panel. 

• Case 37299 
A new command line argument -js_encrypt has been added so JavaScript files can be encrypted 
from the command line. It outputs a file in the same directory as the specified file, with the suffix 
'_encrypted.js'. 

• Case 34641 
FMH Script - SR2 can be calculated with respect to APR or BPR (or RPR if there is no B-pillar). 
The program uses APR by default. Added option to use BPR or RPR instead. 

Undo 

• Case 37800 
UNDO option is now available for renumbering entities in a model. 

Ztf 
• Case 38865 
A preference has been added (primer*ztf_output_composite_action) to save the chosen action 
when writing out a ztf file containing composite data. The actions correspond to those on a 
dialogue box that appears when attempting to write a ztf file containing composite data: 
'Yes_Del', 'Yes', and 'No'. 
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3.2  D3PLOT 

3.2.1  Enhancements in 16.0 

Component 

• Case 38701 
D3PLOT v16.0 can now display a component that shows whether a shell element is in 
compression or tension on both sides of the element, i.e. when a shell element that is in bending 
is rotated on screen it will be contoured in blue when the compression face is visible and red 
when the tension face is visible. Tension or compression is determined based on the largest 
magnitude of the maximum and minimum principal stresses on the surface. Further contour 
bands are green for zero stress and grey for not computed. 
The new data component is available under the ‘Principal Stress’ category and is called 
TC_SHELL_TENS_COMP. 

Constraints 

• Case 34584 
D3PLOT can now read load definitions from the ZTF file v16.0 or later and can plot and contour 
the loads on the model. Loads are shown with arrow symbols. The following load types are 
supported: *LOAD_NODE_XXX, *LOAD_SEGMENT(_SET), *LOAD_SHELL(_SET), 
*LOAD_BEAM(_SET). Only load curves are supported, not functions. 

Cut section 

• Case 34951 
In D3PLOT v16.0 a new option has been added to the cut-section +ve and -ve side options that 
will automatically draw that side using transparency. 

Data components 

• Case 37730 
D3PLOT v16.0 can now read and display values for Strain Energy Density that can be output to 
the d3plot (PTF) and d3eigv files by setting ISED on 
*DATABASE_EXTENT_BINARY_COMP.  
 
The new data component is available for Solids, Shells and Thick Shells and is available under 
the 'Element Energies' data component category. 

• Case 37564 
D3PLOT v16.0 can now read and display the residual forces and moments that can be written to 
the D3ITER file (set by D3ITCTL=1 on *CONTROL_IMPLICIT_SOLUTION) during an 
Implicit run.  
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These components are available under a new 'Residual Forces/Moments' data component 
category. 

Image 

• Case 33971 
D3PLOT v16.0 introduces the following changes to the handling of output image filenames: 
- If an explicit filename (optionally, with path) is typed in or selected for one image type, say 

JPEG, that new filename and path will then become a seed for every image type. Changing to 
a different image type, say PNG, will not require users to browse to the user-defined path 
again. Instead the new seed name will be used for the PNG file with the appropriate 
extension (.png) and a unique 3-digit increment added if needed.  

- Extensions that are an obvious mismatch will be auto-corrected and a warning issued. For 
example, if a user attempts to write out a BMP with the filename myfile.gif, the filename will 
be changed to myfile.bmp automatically. The filename myfile.image will, however, not be 
auto-corrected. 

- If a user-chosen filename exists, clicking the NEW_FILE option will not take the user back 
to the current working directory as was done in the past. Instead, a unique 3-digit 
increment will be appended to generate a new filename. 

- A sub-folder (one level only) is now also automatically created as a part of image creation, if 
needed.  

- All of the above also applies to movie files (AVI, MPEG and animated GIF) and to postscript 
files (PS and PDF). Choosing a new image name will not alter the default filename for movie 
or postscript files. Choosing a new postscript filename will, however, update the default 
filename for pdfs. 

JavaScript API 

• Case 39409 
Added support for DriveMapFilename in the File class for both T/HIS and D3PLOT. 

• Case 39152 
Added IsVisible which returns JS_TRUE if an entity is visible and JS_FALSE otherwise.  
An entity is considered 'visible' if the following conditions are all true:  

- Not blanked  
- The visibility switch is ON for type 'type_code'  
- Is not empty, if type is PART  
- The entity 'item' has not been deleted in the current state if the type is an element 

• Case 31901 
Added the Colour class. This allows colour constants such as Colour.RED to be used inside 
JavaScripts, as well as user-defined RGB colours via the function Colour.RGB(). 
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Measure 

• Case 39403 
When doing a part-part measure it is possible to sketch the parts on each side of the measure. 
Previously it was not possible to remove the sketch without deleting the measure. The sketch 
button can now be used to turn the sketching on and off. 

• Case 39233 
When a measurement is created, the X, Y, Z coordinate and the vector are output to the dialogue 
window.  
 
In D3PLOT v16.0 this has been added for node-to-part or part-to-part measures; and for the 
other types of measure the output has been reformatted to make it clearer.  
 
An oa_pref preference d3plot*measure_dialogue_format_vec_rows has been 
added so users can change the output format from the old format (with the columns as node 1, 
node 2 and distance, and rows containing X, Y, Z) to the more common vector notation with the 
rows containing node 1, node 2 and distance and the columns as X, Y, Z. 

• Case 39154 
The data components menu correctly shows if geometry measure part-part data is available. 

• Case 36255 
Users can now set the number format of the measurement where it is used as an annotation on 
their plots. 

• Case 29137 
Users now have the option 'Transparent' that can be used to display the measurement label 
without a coloured background. 

Output 

• Case 36510 
In the Write >> Keyword Data menu users can now request extra variables to be written to the 
*INITIAL_STRESS_XXX card for beams, shells, thick shells and solids. 

PTF compress 

• Case 34678 
The Cutdown PTF menu (Utility->Compress) now automatically creates a subdirectory if needed 
when writing cutdown ptf files. 

Read 

• Case 39000 
D3PLOT v16.0 now supports the D3ZCF file which contains zero-crossing frequencies with 
positive slope for results from a random vibration analysis.  
 
The random vibration analysis is activated by the keyword 
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*FREQUENCY_DOMAIN_RANDOM_VIBRATION. The dump of this file is activated by the 
keyword *DATABASE_FREQUENCY_BINARY_D3ZCF. 

• Case 38999 
D3PLOT v16.0 now supports the D3ACC file which contains element acoustic pressure 
contribution and contribution percentage on selected field points from a boundary element 
acoustic analysis.  
 
The acoustic analysis is activated by the keyword 
*FREQUENCY_DOMAIN_ACOUSTIC_BEM. The output of this file is activated by the 
keyword *DATABASE_FREQUENCY_BINARY_D3ACC. 

• Case 38998 
D3PLOT v16.0 now supports the binary plot file D3ACP which contains the acoustic pressure at 
field points in BEM acoustic analysis.  
 
The field points are defined by the keyword 
*FREQUENCY_DOMAIN_ACOUSTIC_FRINGE_PLOT. 

• Case 38997 
D3PLOT v16.0 now supports the binary plot file D3ERP which contains ERP (equivalent 
radiated power) analysis results. The analysis is activated by the keyword 
*FREQUENCY_DOMAIN_SSD_ERP. 

• Case 27275 
D3PLOT v16.0 now supports the DCOMP (*DATABASE_EXTENT_BINARY) options 5 and 6 
which can be used to reduce the size of the PTF (d3plot) files by removing data for nodes that 
are only connected to rigid bodies. 

Settings file 

• Case 38646 
D3PLOT v16.0 introduces the ability to create “sessions” which can later be restored. This 
permits users to quickly revert to the state they were at when they last exited D3PLOT. Sessions 
may be saved explicitly or unconditionally upon exit using new preferences.  
 
Sessions are a combination of, and an extension to, the functionality already provided by settings 
and properties files.  
- Model names (results filenames) are embedded. A previously saved session may be loaded as 

is, or with a similar, but different, set of results files.  
- Model attributes, visibility and other properties are restored.  
- Model-independent information such as the “menu attributes” are saved in sessions.  
- Extra information such as state selection for envelope plotting is included in session files. 
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Write 

• Case 37051 
D3PLOT v16.0 can now write *ELEMENT_SHELL_THICKNESS cards for thin shell elements 
from the Write KEYWORD Data menu. The thickness value written for each node is the nodal 
average value based on the connected shell elements. 

XY plot 

• Case 37855 
XY data curves that are exported from D3PLOT to T/HIS now carry additional information such 
as model number, entity type and entity label. These may be used for curve filtering. 
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3.3 T/HIS 

3.3.1 Enhancements in 16.0 

Curve menu 

• Case 35579 
Added in functionality for moving and copying multiple curves in the T/HIS curve 
manager. 

Curve table 

• Case 38972 
The curve table has had multiple new features added:  

- Curve properties and injury values can now be displayed in the curve table.  
- The columns that are displayed can be customized in the “View” popup and 

reordered by dragging column headers. Columns can also be hidden by right-
clicking the headers.  

- The choice of displayed columns can be saved to preferences. 
- The whole curve table can be written out to either a .csv or .xlsx file.  
- Curves can be annotated with a property or injury value by right-clicking the 

value in the curve table and selecting “Annotate”. 
- Options for customizing annotations can be found in the “Annotation options” 

popup. The options include the format of the displayed value, whether to 
highlight the relevant point on the curve and the ability to add either an 
automatic or user-defined label to the annotation.  

- Curves can be operated on by right-clicking them in the curve table and 
selecting “Functions”, then choosing the desired operation. 

Curves 

• Case 25840 
Added a header to the 'Properties...' pop-up, accessed via right-clicking on a curve, 
which displays the curve number of the curve that the properties are associated with. 
• Case 38117 
New line widths have been added, so now any pixel width 1-10 can be chosen, rather 
than previously just 1,2,4,8. 

Data access 

• Case 37093 
T/HIS can now read curvout data from both LSDA (binout) and ASCII (curvout) files. 
The curves are treated as entities and can be selected individually in the usual entity 
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list in the read panel. Any titles given to the curves will be written into the .ztf file by 
PRIMER and read into T/HIS. 

FAST-TCF 

• Case 14968 
FAST-TCF variables relating to all curves have been added, which have the variable 
names: all_minx, all_maxx, all_miny, all_maxy, all_xatmin, all_xatmax, all_catmin, 
all_catmax. These return the min/max x value, min/max y value, x at min/max y value 
and curve number at min/max y value respectively, where these properties are taken 
over all curves in the current T/HIS session. In order to create these variables, the 
curve number word in the FAST-TCF command needs to be replaced with 'all'. 

• Case 22506 
The most recently created/edited curve or the curve with the highest ID can now be 
tagged in a FAST-TCF script using, respectively, the commands:  
 
tag recent curve_tag  
 
tag highest curve_tag 

• Case 36335 
Added an option to the FAST-TCF create panel, so that a user can choose to write 
entity names (when they exist), in place of IDs, into any generated FAST-TCF script. 
These names are then used to identify the entities when the user runs the script. 

• Case 37583 
Added commands colour and colour_rgb to FAST-TCF which allow the user to define 
up to 6 colours using either 6-digit hexadecimal format or three integer r g b format 
respectively. These commands will also be written into any FAST-TCF script that is 
generated in T/HIS if there are user-defined colours in the preferences file. 

• Case 38900 
When writing FAST-TCF script file for the curves generated through a JavaScript, 
FAST-TCF now adds a tag command for each curve generated. Now curves generated 
through JavaScript can be used inside FAST-TCF. 

Graphics 

• Case 31263 
Added the option to change the colour of the legend label text to 'Curve' so that the 
text colour is the same as the curve which it represents. 
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Graphs 

• Case 34326 
Added 'Regres' operation with Linear, Polynomial (degree 1-4), Logarithmic and 
Exponential regression options. This works with JavaScript and FAST-TCF. The 𝑅𝑅2 
value for goodness of fit of the output curve is written into the label. The 𝑅𝑅2  value 
along with the curve equation can be viewed via right-clicking the curve and selecting 
'Properties'. In the case of linear regression extra statistical data for the curve is also 
given in this properties pop-up. 95% Confidence and prediction bands can also be 
displayed around any linear regression curve. 

• Case 38911 
Two new FAST-TCF commands are added to autohide and show the graph toolbar 

layout graph toolbar autohide  
layout graph toolbar show 

Image 

• Case 39332 
T/HIS v16.0 introduces the following changes to the handling of output image 
filenames:  

- If an explicit filename (optionally, with path) is typed in or selected for one 
image type, say JPEG, that new filename and path will then become a seed for 
every image type. Changing to a different image type, say PNG, will not 
require users to browse to the user-defined path again. Instead the new seed 
name (along with an increment) will be used for the PNG file with the 
appropriate extension (.png) and the increment modified if needed. 
 

- Extensions that are an obvious mismatch will be auto-corrected and a warning 
issued. For example, if a user attempts to write out a BMP with the filename 
myfile.gif, the filename will be changed to myfile.bmp automatically. The 
filename myfile.image will, however, not be auto-corrected. 
 

- If a user-chosen filename exists, clicking the NEW_FILE option will not take 
the user back to the current working directory as was done in the past. Instead, 
a unique 3-digit increment will be appended to the same name to generate a 
new filename. 
 

- A sub-folder (one level only) is now also automatically created as a part of 
image creation, if needed. 
 

- All of the above now also applies to postscript files (PS and PDF). 
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JavaScript API 

• Case 30468 
The function Colour.RGB has been added to the T/HIS JavaScript API, allowing 
JavaScript widgets to be coloured with general RGB colours. Objects in T/HIS such 
as curves, lines and text cannot be coloured using this function, they must be coloured 
from the defined set of colours or one of the six user-defined colours. 

• Case 31735 
Added a global JavaScript function SetCurrentDirectory to both T/HIS and PRIMER, 
which sets the current working directory to a given path. Also added the PRIMER 
JavaScript functions GetCurrentDirectory, GetStartInDirectory, GetInstallDirectory 
and GetPreferenceValue to T/HIS JavaScript. 

• Case 34909 
Added 'component' to curve properties in the JavaScript curve class. 
'Curve.component' returns the JavaScript label for the component, which is used in the 
GetDataFlagged function call. For example SPC_FX for SPC X-force. 

• Case 36599 
A Page class has been added to the T/HIS JavaScript API with functions 
ReturnActivePage and SetActivePage, which return and set the current active page 
respectively. 

• Case 37957 
Added properties to Group class in JavaScript. These are values relating to all the 
curves in a group, such as the minimum and maximum y-values of any curve in the 
group. 

• Case 37959 
Functions have been added to the Page class in the JavaScript API, Page.AddGraph, 
Page.RemoveGraph, Page.Layout and Page.ReturnGraphs. Respectively, these allow 
graphs to be added and removed from pages, the layout of individual pages to be set 
and the graphs present on a page to be returned. 

• Case 39012 
T/HIS JavaScript Graph class can be used to create graphs and modify their properties 
such graph axis, label, units and legends. 

• Case 39326 
Created a Read class in the T/HIS JavaScript API. This has functions Read.Cur to 
read .cur files and Read.CSV to read CSV files, with a number of options to specify 
the format of the CSV file that is to be read in. 

• Case 39409 
Added support for DriveMapFilename in both T/HIS and D3PLOT.  
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• Case 39493 
Added new functions Read.Key/LSPP/ISO/Bulk/DIAdem to read each of the 
corresponding file types into T/HIS from inside a JavaScript. Information on how to 
use these functions can be found in the users’ manual. 

LSDA (binout) 

• Case 38996 
T/HIS v16.0 has been updated so that the code used to read and extract data from the 
LSDA (binout) file is based on the R11 LS-DYNA source code. 

Operations 

• Case 35455 
Changed behaviour for all operations, so that if all input curves are plotted on the 
secondary y-axis then the output curve will also be plotted on the secondary y-axis. 

• Case 39411 
Significantly improved the performance of the 'Rolling Average' operation when a 
time window has been specified for curves with a large number of points. 

Preferences 

• Case 31728 
Added preferences 'hic_time_window' and 'hic_scale_factor', which allow the default 
time window and scale factor for the HIC automotive operation to be set to any 
positive real values. 

• Case 38910 
A new preference this*auto_hide has been introduced to auto hide the graph toolbar 
by default. It can accept either TRUE or FALSE. Default value is FALSE. 

Read 

• Case 34154 
T/HIS now reads the SPC set IDs from both ASCII and LSDA files and allows force 
data to be plotted per set or per model. The force component chosen is summed over 
all SPCs in the set or model and output as a single curve. 

• Case 39005 
Added support for the latest AIRBAG and AIRBAG part data components. 
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• Case 39006 
T/HIS can now read new BNDOUT data components X-,Y- and Z-moments for 
discrete nodal loads and velocity nodal loads from both LSDA and ASCII files. 
 

Settings file 

• Case 38660 
User can now save and retrieve a T/HIS session. Users can also append/overlay two 
different T/HIS sessions.  
 
Users can also generate a new session for a new run case just by updating the path of 
the LS-DYNA results from an existing session file. 

T/HIS link 

• Case 36690 
Timelines can now be viewed for Data vs Data XY curves when taken across from 
D3PLOT to T/HIS. These timelines are represented as symbols rather than as lines, as 
is done for combined curves. 
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3.4 REPORTER 

3.4.1 Enhancements in 16.0 
 

Standard templates 
• Case 36964 
EuroNCAP Head Impact can now identify the row and column numbers from folder 
name of format <zone>_<row>_<col> if the key file does not follow this format. If 
both .key file and folder names do not follow the required format a warning will be 
thrown informing the user that the specific grid point will be skipped. 

Tables 
• Case 38250 
Various new functions have been added to the Item class of the JavaScript API to 
enable control over Table and Autotable items. It is now possible to: 
insert/delete/resize rows/columns, merge/unmerge cells, get/set cell properties (e.g. 
text, alignment, font, colour, border width) and get/set cell conditions. 

• Case 38249 
Table and Autotable items can now be exported in Microsoft Excel format, complete 
with formatting (cell size, text alignment, font style, borders, colours, merged cells). 

Text 
• Case 9008 
Previously, REPORTER only supported four fonts (Courier, Helvetica, Times, 
Symbol). REPORTER now supports many more fonts (TrueType, OpenType, and 
certain Type1 fonts), giving you greater control over the look of your reports, and 
allowing you to create templates that match your organisation's branding. Support for 
Chinese, Japanese, Korean and other non-Latin fonts is much improved. 
 

 

  



Oasys Ltd LS-DYNA Environment Software Release Notes 
Version 16.0 

 

Ove Arup and Partners Limited |  Final |  March 2019  
 

Page 64 
 

3.5 SHELL 

3.5.1 Enhancements in 16.0 

Manuals 
• Case 37386 
In version 16.0, the “SHELL (What’s New)” pdf listing new features for the SHELL can now be 
accessed easily by clicking on the “Manuals” button in the main SHELL window. 
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